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Thank you for your interest in WriteWay! You are about to take your book ideas and story 
compositions to a whole new level of organization, clarity, and execution--all in one easy-to-use, 
affordable package. 

 

With WriteWay, you will be able to: 

• Organize -- Collect and record all of your book ideas, notes, photos, reference sources, character 
information, etc. No more sticky notes, spiral pads, or cocktail napkins to dig through or misplace!  

• Character Profiles -- Generate and maintain detailed character profiles--complete with graphic 
images you import from your computer or the web--and access your story people at the click of 
your mouse  



• Story NoteCards -- Sketch out the plot and scene ideas for your book--as vague or as detailed as 
you like--using digital NoteCards, accessible from anywhere in WriteWay  

• Outline -- Build your book outline on the fly and make changes using simple drag-and-drop 
controls  

• Composition -- Compose your manuscript using WriteWay's powerful word processor, from which 
you can either directly print your manuscript or export as an RTF file for use in the word processor 
of your choice  

• Dictionary and Thesaurus -- Spell-check using WriteWay's dictionary, which contains more than 
a quarter of a million words; access a myriad of synonyms with the software thesaurus  

• Reports and Stats -- Monitor your word count by chapter, scene, and book; analyze your word 
usage to help you pinpoint and eliminate repetition in your manuscript (and those pesky adverbs 
that can bog down your prose!)  

• Wordcount Tracking and Deadline Management -- Set up deadlines and monitor your 
progress toward your completion goals with comprehensive charts, graphs, and logs produced 
from your daily word/page count output  

• NoteCard Templates -- Make use of WriteWay's preloaded NoteCard templates or design your 
own custom formats to suit your specific needs  

• Front and Back Matter Pages -- Optionally create and maintain your manuscript's Front Matter 
and Back Matter for submission and electronic publishing such as cover art, cover page, reviews, 
copyright, dedication, acknowledgments, forward, author notes, glossary, and bibliography, all 
with direct printing capability or export in PDF, Microsoft Word Format 97-2003 (*.doc), and 
Microsoft Word Format (*.dox).  

• Printing -- Generate hard copies of your manuscript in draft or submission format; book 
outline and/or scratchpad only; or print your NoteCards in combinations of one, multiples, or all 
NoteCard topics  

• Export -- to other programs such as Rich Text Files (RTF), Hypertext Markup Language (HTML), 
Adobe Portable Document Format (PDF), Microsoft Word Format 97-2003 (*.doc), and Microsoft 
Word Format (*.dox), making it easy to upload and publish your own content at Amazon.com in 
Kindle, BN.com in NOOK and Kobobooks.com in ePub formats. 

WriteWay Professional users also enjoy the following advanced features: 

• Storyboard -- View, update, or re-sequence your book's digital NoteCards in a visual "storyboard" 
layout, with options to view all, a user-selected few, or one NoteCard topic at a time  

• Import Function -- Transfer in your current work-in-progress from another word processor to 
WriteWay Professional with a few easy clicks of your mouse  

• Synopsis Function -- Compose your book's synopsis in WriteWay Professional, with direct 
printing capability or export  

• Front and Back Matter Pages -- Optionally create and maintain your manuscript's Front Matter 
and Back Matter for submission and electronic publishing such as cover art, cover page, reviews, 
copyright, dedication, acknowledgments, forward, author notes, glossary, and bibliography, all 
with direct printing capability or export in Rich Text Files (RTF), Hypertext Markup Language 
(HTML), Adobe Portable Document Format (PDF), Microsoft Word Format 97-2003 (*.doc), and 
Microsoft Word Format (*.dox).  

• Research Folders -- Collect and maintain all of your book's research and reference sources in 
easy-to-use folders, which allow for text and image/photo combinations, as well as URL hotlinks to 
websites you'd like to record and/or visit as you write your book  

• Future Book Ideas Folder -- Record your future story ideas, series notes, etc., directly in 
WriteWay Professional, which can later be moved to new book files as you begin work on future 
projects  

• ARCs/Galleys -- With a single click of your mouse, convert and print your manuscript into a 
professional-looking, two-column, single-spaced landscape format for use as ARCs/Galleys for 



reviewers, promotions, etc.  

• Listen -- Have your prose read back to you from the Preview section of WriteWay using your 
computer's text to speech installed program. 

WriteWay was developed in cooperation with authors in various stages of publication, from beginning 
writers working on their first manuscript, to multi-published, nationally best-selling authors with years of 
experience under their belts. We think you'll agree with them--that writing a book has never been so 
easy, or so much fun! So, let's get you started, shall we?  

*Note: Using the Demo Version vs Using a Licensed Version.  
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The WriteWay Standard and WriteWay Professional Editions utilize the same program as the 30-
day WriteWay Demo Edition. The Demo Edition is a fully functioning version of WriteWay 
Professional, except that printing and exporting functions have been disabled. With the Demo Edition, 
you will be able to import and create new books or view and modify the pre-loaded sample book included 
with the software.  

 

Once you have purchased a copy of WriteWay and registered it, anything you've created or imported in 
the Demo Edition will be available to you in the "live" licensed version. WriteWay Standard and 
Professional Editions utilize the same program as the Free Demo version. Just open the WriteWay Demo 
and go to 'File' then 'Register WriteWay'. Enter the email address and license number, sent to you via 
email, in the appropriate spots via Register WriteWay and it will unlock your purchased version of 
WriteWay for you. You will not lose any of your saved work. However, if you have purchased the Standard 
Edition, be aware that any Professional features you have used in the Demo Edition (such as research 
folders, future story idea folders, synopsis, miscellaneous pages, etc.) will NOT be enabled under 
Standard Edition. Any information contained in those features will not be accessible to you in Standard 
Edition. Should you later upgrade to Professional Edition, you will once again have access to any 
information contained in those advanced, Professional Edition features. 
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Ordering is easy! 
 
You can purchase WriteWay online: http://www.writewaypro.com/purchase.php 
 
We use PayPal as a payment service provider that supports: MasterCard, Visa, American Express, 
Discover, and a direct withdrawal from your Bank.  
 
We also take Cashier's Checks and Money Orders in USD, by filling out this form: 
http://www.writewaypro.com/purchccmo.php  
 
Make your cashier's check or money order payable to "WriteWayPro, LLC" and mail to:  
 
WriteWayPro, LLC  
PO Box 365  
North Conway, NH 03860-0365  
USA  
 
Once your order is complete, your registration license will be immediately sent via email to unlock the 
software for use. 
 
The cost for WriteWay depends on which copy of WriteWay you are wanting to purchase. The latest 
pricing information is available on our WriteWayPro.com website. 
 
Feel free to visit the WriteWayPro.com web page and place your order: 
http://www.writewaypro.com/purchase.php 
 
Note: For those who wish not to use their PayPal account or do not have a PayPal account: 
 

• Go to Purchase page: http://www.writewaypro.com/purchase.php 
• Click on ‘Buy Now’ even though you want to pay without PayPal services.  
• You are then transferred to PayPal. The picture below is an example of what you are looking for on 

the next page. 

  
 

• Click on the pictured 'Link'. 
• On the next page—you will need to fill out the bottom portion that says ‘Pay with debit or credit 

card’. 
• After filling this out, click Review and Continue. 
• PayPal may pop up a page that asks: ‘Did you know you have a PayPal account?’ Then prompts 

you to sign in. But right next to the button that says ‘Log in and Continue’ you will see a little line 
that says, ‘Continue without logging in’. Click that line and ignore the prompt to log in. 

• You will then be taken to a new page that has a yellow box that says ‘Pay now’.  
 
If you wish to avoid PayPal altogether, WriteWay is for sale on Amazon.com as well.  Professional: 
 http://www.amazon.com/gp/product/B005DM5QEK or Standard: 
http://www.amazon.com/gp/product/B006VF7LO6. 
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WriteWayPro, LLC 
End User License Agreement 
 
BEFORE YOU DOWNLOAD OR INSTALL WRITEWAY, CAREFULLY READ THE TERMS AND CONDITIONS OF 
THIS AGREEMENT. BY DOWNLOADING OR INSTALLING THE SOFTWARE YOU ARE CONSENTING TO BE 
BOUND BY AND ARE BECOMING A PARTY TO THIS AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THE 
TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE THE SOFTWARE. 
 
WriteWay Authoring Software 
Copyright (c) 2003-2012 by WriteWayPro, LLC 
All rights reserved. 
 
SOFTWARE LICENSE 
WriteWayPro, LLC grants to you a limited, non-exclusive, non-transferable, License to use this version of 
WriteWay (the "Software"), in binary executable form. 
 
This License is personal to you and you agree not to assign your rights herein. This License shall be 
governed by and construed in accordance with the laws of the State of New Hampshire and, as to matters 
affecting copyrights, trademarks and patents, by U.S. Federal law. This License is a legal document which 
constitutes an agreement between you and WriteWayPro, LLC. This License sets forth the entire 
agreement between you and WriteWayPro, LLC. 
 
The Software and related documentation are protected by copyright and trademark laws. You have the 
non-exclusive right to use the Software. If you have downloaded an evaluation or demonstration copy, 
the Software may have an expiration date at which point your license to use said evaluation copy will 
terminate. This Software can only be used on a single computer. You may load the Software on up to four 
(4) computers provided that the Software is used on only one computer at a time. 
 
You may not electronically transfer the Software from one computer to another over a network. You may 
not make modifications of any kind, either to the Software itself or the environment in which it operates. 
You may not distribute copies of the Software or documentation to others. You many not modify, 
translate, disassemble, or reverse engineer in any way the Software or related documentation without 
prior written permission of WriteWayPro, LLC.  
 
INSTALLATION, BACKUP AND TRANSFER 
The Software will allow only a limited number of installations before requiring a password for additional 
installations and/or may require web validation from www.WriteWayPro.com before functioning. Once 
installed into a computer, you may make one copy of the Software to be used solely for backup purposes. 
You must reproduce and include the Software copyright notices on the backup copy. All other copies of 
the Software, including software that has been modified, merged, or included with other software and its 
documentation are in violation of this License agreement. You may not at any time transfer any portion of 
the Software or the License agreement to another party. 
 
WARRANTY 
The Software is provided "as is" without warranty of any kind; the entire risk as to the quality, results and 
performance of the Software is assumed by you and you assume the entire cost of all necessary servicing, 
repair or correction. WriteWayPro, LLC makes no representation or warranties with respect to the contents 
hereof and specifically disclaim any implied warranties of merchantability or fitness for any particular 
purpose. Further, WriteWayPro, LLC does not warranty, guarantee, or make any representations 
regarding the use of or the results of use of the Software in terms of correctness, accuracy, reliability, or 
otherwise; and you rely on the Software and its results solely at your own risk. WriteWayPro, LLC shall 
have no liability or responsibility to you or any other person or entity with respect to any loss or damage 
caused by the Software including, but not limited to, any loss of profits, interruptions of service, loss of 
business, or consequential damages resulting from the use of such Software. In no event shall 
WriteWayPro, LLC or any of its principals be held liable for any indirect, incidental, collateral, exemplary, 
consequential or special damages or losses arising out of your download, installation, or use of the 
Software. WriteWayPro, LLC is not required to support or issue updates to the Software. 

http://www.WriteWayPro.com


 
GENERAL 
If any provision of this License agreement shall be unlawful, void or for any reason unenforceable, then 
that provision shall be deemed severable from this License agreement and shall not affect the validity and 
enforceability of the remaining provisions of this License agreement. 
 
Should you have any questions concerning this License agreement, please email WriteWayPro, LLC at 
contact@writewaypro.com 
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Internet connection optional 

After you purchase a license for WriteWay Standard or WriteWay Professional, you will receive via email a 
license number that you will need to use for registering your downloaded trial version to unlock the "live" 
version (with printing and exporting features enabled). To complete this easy, one-time process, simply 
start the WriteWay program as you normally would, then click the File menu. Select the item called 
"Register WriteWay."  

 

WriteWay Standard and Professional Editions utilize the same program as the Free Demo version. Once 
you purchase WriteWay, there is no additional software to download. Type in the required information 
from your Purchase Confirmation email from WriteWayPro.com, then click the "Register" button and your 
copy of the software will be activated to the WriteWay Edition that you purchased. If you have an active 
Internet connection, though not required, WriteWay will send your registration information to the 
WriteWayPro.com website. It's that simplet! Once complete, you will be returned to the main workspace 
screen where you can either exit the program or begin using your live copy.  

Note: You are allowed to use WriteWay on up four (4) different computers for your own personal use per 
the WriteWay End User License Agreement. You will need to install the WriteWay Demo and register it on 
all computers using the WriteWay installation program (wwSetup.exe).  
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Internet connection optional 

If you are planning on using WriteWay on a newly purchased computer and no longer plan to use 
WriteWay on your old computer, you should un-register WriteWay on the old one. Simply start the 
WriteWay program as you normally would, then click the File menu. Select the item called "Register 
WriteWay." The below small screen will show your First/Last name, email address and license number in 
their respective spaces.  

 

Just click the "Unregister" button and your copy of the software will be reset to the WriteWay Demo 
Edition.  
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Get the latest news and update information by following us on:  
 

Twitter : http://twitter.com/WriteWayPro or on Facebook : 
http://www.facebook.com/WriteWayPro 
 
 
For more information about WriteWay, including our new video tutorials, please visit our website:  
 

www.WriteWayPro.com or our YouTube channel : http://www.youtube.com/WriteWayPro 
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At the core of WriteWay's design was the idea that software products for writers could be flexible and 
easy to use, yet still be comprehensive and powerful enough to incorporate each component of a novel's 
creation, from initial concept and characters to finished manuscript. Without forcing you to adopt complex 
or rigid storytelling philosophies, or limiting you to the development of ideas alone then directing you 
toward a separate word processor in which to compose your book, WriteWay brings together all the pieces 
of the novel writing process and houses them in one place. Using WriteWay, you will create and manage 
each of those story components in one seamless product, keeping all of your relevant information at your 
fingertips as you brainstorm, plot, and compose your novel's prose. 

Whether you are a writer who begins with fully conceived outlines, conflict and character ideas, 
disconnected snippets of plot, or if you jump right into your writing and begin typing prose the moment 
you come to the computer, WriteWay is flexible enough to work the way you do. Begin with one feature, 
then start another when you're ready. You can even ignore all of the plotting and character features and 
simply use WriteWay as your word processor of choice, composing your novels, printing manuscripts and 
ARCs (galleys) directly out of the software, or exporting to other programs such as Rich Text Files (RTF), 
Hypertext Markup Language (HTML), Adobe Portable Document Format (PDF), Microsoft Word Format 97-
2003 (*.doc), and Microsoft Word Format 2007 and above (*.dox). 

For those writers who enjoy pre-work on plotting and character development, WriteWay delivers 
everything you need in one easy-to-use product. By setting up story NoteCards to track plot threads, 
conflict development, dialog, suspense, etc.; and character profiles that contain physical descriptions, 
photos, back-story, personality traits, etc., you will save time and effort by housing all of your pre-work 
notes and ideas in WriteWay, where you can access it with a click of your mouse. WriteWay Professional 
Edition also offers a storyboard function for visual display and management of your story NoteCards; 
research folders for notes, website URLs, file links, images, etc.; and many more advanced writing 
features for power-users. 

To add a further level of organization, WriteWay allows you to create personalized templates that you can 
use as a base structure each time you create a new character or story NoteCard. No more reinventing the 
wheel each time you begin a new book. Are you writing mysteries and romance novels? Set up character 
profiles and story NoteCard templates tailored to each genre's specific requirements. Incorporate prompts 
or craft tips into your templates to help you stay focused as you create your book and the characters who 
will populate it. We have included some basic sample templates in your copy of WriteWay, but you need 
not limit yourself to just those few. The samples are intended to provide you with ideas of various story 
elements and how you might use them in your books. Modify the sample templates as you see fit, use 
them as is, or start your own templates from scratch -- there is no limit to the number of templates you 
can create, and no set format for how your templates should look. 

WriteWay's composition function is also tailored to serve the needs of the fiction writer. You will notice the 
spine of composition is the book outline frame as seen from the WW Sample Book below.  



 

 

The outline contains section breakdowns for Acts, Chapters, and Scenes, which are the major portions of 
a novel's construction. Below the Acts of your book, you have a section called the Scratchpad, which is 
where you can store prose that has no specific chapter or scene destination at the moment; cut text that 
you do not want to lose entirely; or placeholder chapters or scenes that contain little more than 
NoteCards of ideas. Any item on the book outline or Scratchpad can be dragged and dropped (moved) to 
any location on the outline with a click of your mouse by first clicking on the item you want to move. 
Rearrange sections of your story as you wish, whenever you wish. WriteWay will automatically re-
sequence chapter numbers as you move them. 

Beyond the basic construction of your novel, WriteWay provides several other features of particular 
interest to writers, such as: word count and word usage reports; synopsis and Front and Back 
Matter allowances (e.g., dedication, acknowledgments, author notes, etc.); future book idea folders, 
which can later be incorporated into book files as the ideas are fleshed out; and an import feature to bring 
in your existing manuscript files for use and maintenance in WriteWay. 

From initial concept and characters, to completed manuscript . . . you really can do it all --- the 
WriteWay! 
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WriteWay contains five function menus, . The menus and 
their functions are as follows: 

File 
Like most other word processor File menus, WriteWay's File menu contains functions for creating a new 
book , opening and closing projects files; accessing recently opened books; saving and deleting project 
files; printing and previewing project files; and exiting the software. 

One feature that needs mentioning is "Save As...". As expected, this feature can be used to save extra 
copies or versions of your books, but also can be used to add or remove a password to an existing book 
by overriding the book file with a new password or clearing an old password. 

 

In addition to those basic software functions, you will also find several WriteWay setup functions listed 
under the File menu. Those setup functions, which will be explained in detail further along in this 
document, include: Save Snapshot; Import Book Chapters; Preview Book; Master Templates for 
Characters and NoteCards; Master NoteCard Types; Future Book Idea Folders; Copy and Restore; Sample 
Book; Automatic Expand Outline; Automatic Title/Name Prompt; AutoSave Options, Background Color 
Options (change from Default Blue to Gray); Ctrl - A = Select All (activate shortcut Ctrl + A); and 
Register WriteWay. (Note: Future Book Idea Folders are available in WriteWay Professional Edition. 
Standard Edition will contain the menu item, but the function is disabled.) 

Book 
The Book menu contains functions for adding and deleting scenes; changing scene colors; setting and 
resetting Scene Flags and clearing Scene Flags; changing the Storyboard properties; accessing and 
maintaining your book's Synopsis; accessing and maintaining Character Profiles and Research Folders for 
the current book; displaying your Book Outline in either collapsed or expanded mode for easy viewing; 
and accessing and maintaining Book Properties. Note: Storyboard, Miscellaneous Pages, Synopsis, and 
Research Folders are available in WriteWay Professional Edition. Standard Edition will contain these menu 
items, but the functions are disabled. 

Edit 
Like most other word processor Edit menus, WriteWay's Edit menu contains functions for undo/redo; cut, 
copy, and paste; select all; resetting text defaults; font settings; tab settings; insert symbol; bullets and 
numbering; "find" functions; spell-check; thesaurus; and the ability to choose your default dictionary. 

View 



The View menu contains functions for displaying various elements of the WriteWay workspace. Using this 
menu, you may generate and view Word Count and Word Usage Analysis reports; view Word (or Page) 
Count Tracking and deadline management charts and logs; Hide or Show Main ToolBar from view; Hide or 
Show Ruler from composition, hide NoteCards or scene text; or switch from NoteCard workspace to 
Storyboard mode, full screen composition mode, etc. Note: Storyboard is available in WriteWay 
Professional Edition. Standard Edition will contain this menu item, but the function is disabled. 

Window 
Like most other Window menus, WriteWay's Window menu allows you to see your active file(s) and switch 
between them by selecting the desired file with a click of your mouse. Under WriteWay's Window menu, 
you will also find an item called Arrange Book Forms. Using this function, you can either: Maximize All 
Forms, which will resize all active forms (composition screen, character profile screen, etc.) to stretch 
individually to full screen; or Position Forms to Default Locations, which will reset all active forms to their 
software-set original sizes and positions on the screen. For example, if you had moved the character 
profile screen to the left of the screen, this function would replace it back on the right of the screen, at the 
default position. 

Help 
Like most other Help menus, WriteWay's Help menu contains the standard access items for the Help 
Topics (the document you are reading now) and About, which displays for informational purposes your 
current operating version of WriteWay and your personalized "Licensed to:" information for the copy you 
are running. On the Help/About screen, you will also find WriteWay's software update feature, which can 
be manually accessed by clicking the "New Release?" button. If you have a question or need to contact 
us, you can click the "@ Contact Us" button to send us an email. 

 

WriteWay's Toolbar contains many of the same functions you will find on the software Menus, each 
accessible by clicking your mouse on the icon representing the function you wish to use. The Toolbar also 
contains some additional items, indicated by the following icons: 

 

Top row of Toolbar Buttons in order are: Exit WriteWay, New Book, Open Book, Save Book, Print 
Preview, Add Chapter, Add Scene, Display/Hide NoteCards, Display/Hide Composition Text, Switch 
between Storyboard and Composition, Full Screen, Display Character Profiles, Display Book, Display 
Research Folders, Find/Replace, Book Properties, Word Tracker Reports, Help 



 

Bottom row of Toolbar Buttons in order are: Spell Check, Undo, Redo, View Percent, Font Setting, 
Font Size Setting, Bold Font, Italic Font, Underline Font, Left-justify Text, Right-justify Text, Center Text, 
Full Justify Text, Bullet List, Numbered List. 
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WriteWay is comprised of several major book components--the tools you will be using to organize, 
plot, and compose your story. You may start with any of them, in any order, or skip them all and begin 
writing immediately in the composition area shown below. The first Chapter and Scene are created for you 
on the Outline. For the purposes of this Help topic, we're going to take you through the most logical 
sequence, showing you how to prepare and personalize your copy of WriteWay to work the way you do. 
We begin with you having installed WriteWay and started the software for the first time.  
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There are two sorts of templates in WriteWay: Master Character Templates, and Master NoteCard 
Templates. As their names suggest, each template addresses a different area of development in the 
creation of your books. 

Character Templates are the base structure that will appear on your Character Profiles each time you 
create a new character.  

Character Templates may contain information fields that prompt you to think about and document a 
character's backstory, personality traits, physical description, etc. Each character's specific profile will, of 
course, contain different data, but the template from which you record that data can be the same from 
character to character if you use a Master Character Template as the spine of your character profiles. 
Think of the Character Template as a sort of character interview form. You'll use the same form for each 
character interview, but the answers will be as individual as your characters themselves. 



 

NoteCard Templates are the second form of template in WriteWay.  

These are slightly more complex than Character Templates because not only do NoteCards use master 
templates for their layout, but they also use master NoteCard types to differentiate the various topics you 
can record on the NoteCards (plot, conflict, etc.), which are then available for selection within your 
individual books. The sort of things you might find on NoteCards and NoteCard templates include: plot 
cards, with master templates for specific genres such as romance, mystery, or thriller novels; conflict 
cards, with master templates that prompt you to record the internal and external conflicts of a scene or 
chapter and the next escalating step relating to that conflict; setting cards, with master templates for 
specific time-frames (if you write both historical novels and contemporary) and locations; etc. 



 

To view and experiment with both Master Character Templates and Master NoteCard Templates, see the 
software samples which come pre-loaded in your copy of WriteWay, which will be addressed in the next 
few steps of this user's guide. 
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Master Character Templates can be set up on-the-fly, while you are adding new characters to your 
book, or in the beginning of your work on a new book, as you are setting up the various other initial 
properties and features. For explanation purposes, it may be clearer to address the setup of Character 
Templates from a beginning standpoint, as a function you will perform soon after you open WriteWay and 
before you actually begin adding characters to a new book. 

Master Character Templates.  

From the file menu, select Master Character Templates. This brings up the below screen, where you can 
either choose to use a pre-loaded sample template for your characters (the default), or create your own 
using the character charts and other people-making tools of your own design or preference. The sample 
template will give you an idea of how you might format your own custom forms.  

 



Creating a new Character Template form. 

Click the Add button on the Master Character Template Toolbar. Type in a name for the new template you 
are creating. Note that this field is not asking for a character's name, but rather the name you would like 
to use for this particular character template layout, which will be available to you in any new books you 
create in WriteWay. For example, if you are writing genre fiction, you might want to call your character 
template(s) "Romance Characters" or "Mystery Characters". Don't worry about getting it perfect; you can 
always change the template name later by clicking the Rename button on the Master Character Template 
Toolbar. 

 

Before you click Create, you should decide whether you wish to use the layout of the sample (default) 
template as a base for your new template, or start from scratch. Even if you use the sample template, 
you will still be able to change any and all data contained on the form. Let's say you're starting your new 
character template from scratch. Click Use Blank Template then click Create. This will result in a new 
Character Template screen, which is now ready for you to input your own custom criteria and format. 

Create Template Top 

The top portion of the Character Template contains space for basic character information and a photo, 
which you can later load for each individual character with the image of your choice (.gif, .jpg, .bmp, 
scanned image, etc.). If you use photos, once you are in the Character Profiles section of WriteWay, you 
can right click on the top portion of the screen and Insert Image, dragging it where you want the photo 
situated. Note: Added photo will always position to top left of screen, so if adding a second photo, it may 
position beneath the photo. Drag the top photo to find the second added one. You can then position them 
how you want them. Use right click Resize to alter the size of your inserted image. Go ahead and type in 
some data fields on the character information field. Character Templates can be modified at any time, so 
again, don't worry about getting it perfect the first time. 

 

Create Template Bottom 

The second half of the Character Template is where you can store more detailed information, such as a 
character interview questions, personality traits, backstory details, lists of enemies and allies, character 



flaws, etc. This is where you will establish whatever helps you define your story people and bring them to 
life on the page. Remember, however, that here you are creating a master template--a framework--for all 
your characters. You'll be able to fill out individual responses to your template questions and lists later on, 
as you create your characters in each book. There is no limit to the number of Master Character 
Templates you can create. When you are working within your individual books, your entire list of Master 
Character Templates will be available to you. (For ideas on how to set up the Master Character Template, 
take a look at the default sample included in WriteWay as pictured below. Our layout may inspire you with 
your own creation.) 

 

When you're finished setting up the new Master Character Template, click the Close button on the Master 
Character Template Toolbar. Your changes will be automatically saved. 
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WriteWay's NoteCard function is comprised of two parts: Templates and Types.  

• NoteCard Types contain the various story elements you use to plan and craft your novel, such as: 
plot, conflict, setting, dialogue, revision notes, etc. Additionally, you might use NoteCards for 
managing story threads that are novel-specific or genre-specific, such as: romantic subplots, 
suspense elements, red herrings (if you are writing a mystery), theme, etc.  

 

• NoteCard Templates provide you with design layouts of your various card types--they provide the 
framework that you will use for entering data onto the cards. For instance, if you had a NoteCard 
Type called "Rising Tension," the templates for that NoteCard might look very different if you were 
writing a horror novel versus a romance novel. The "Rising Tension" NoteCard Template for the 
horror novel might contain fields for things like: current body count, clues pointing toward the evil 
entity, etc. The NoteCard Template for the "Rising Tension" card in a romance novel might contain 
fields like: physical intimacy level, sensory details that foster romantic mood, etc.  

 

How you choose to use your NoteCard Types and their related Templates is as limitless as your own 
imagination. To begin using NoteCards, first you must set up Types (or choose from among the pre-
loaded samples), then optionally assign Templates to them as you see fit. 

TIP: Some things to keep in mind regarding NoteCards 



Although you can create an unlimited number of Master NoteCard Types and Master NoteCard 
Templates in WriteWay, the maximum number of NoteCards you can assign to any one book is 
nine (9) unique Types. The minimum number you can assign is one (1) and that type is always set 
to "Plot." 
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From the File Menu, select Master NoteCard Types/Template or from the Master NoteCard 
Types/Templates tab on the Book Properties screen click the Master NoteCard Types/Templates button 
(see below screen). 
  

 

If you are looking at this screen for the first time, you will see that there are ten items contained in the 
grid, labeled Plot Notes, Conflict, Character, Scene Sketch, Setting, etc. These are the pre-loaded samples 
we have created for your convenience. In the far right column of the grid, you will note that most of them 
are using the SAMPLE template and some are not using specified templates. You'll be able to add your 
own NoteCard Templates following the Help topic listed in in the next section of this Help document. 

• Creating New Types: Click the Add button. Your new item will appear as the last entry on the 
grid, with your cursor positioned in the "Note Type" field. Enter a name for the NoteCard type you 
wish to add. The Note Type field will not appear anywhere in WriteWay, but is used as a reference 
key internally within the software. Note Type names are not modifiable once they are set, although 
you can delete them as you wish. After you've added the Note Type name, WriteWay automatically 
fills in this name for the Note "Title." This is merely a time-saving feature; you are not required to 
keep these two name fields the same. The entry you input into the Note Title field will serve as the 
actual NoteCard label, which will be visible on your NoteCard tabs and storyboard.  



• Setting NoteCard Colors: The third field on the grid, "Default Color," is where you will set your 
NoteCard title colors, which are visible in storyboard mode (WriteWay Professional Edition). 
Personalize your NoteCards using colors that speak to you. If it helps, think of them as colored 
sticky notes or index cards, using a unique color for each of the various elements contained in your 
NoteCards. From our samples, you can see that we are using orange for conflict, red for revision, 
green for setting, etc. The Plot card, which is the only required card in WriteWay, has a fixed title 
color of gray. NoteCard colors are changeable as you wish, including those used for the software 
samples. To set or change NoteCard colors, simply click on the color item you wish to change. This 
will bring up a palette screen shown below from which you can assign or reassign designated 
NoteCard colors. 

  

• Selecting Default Templates: The last field on the grid, "Default Template," is where you will 
select a template layout for your NoteCards, if you wish to work with templates. With newly 
created NoteCard Types, the only setting available will be the default of "none." In order to use a 
NoteCard Template for the new Type you are creating, you will first need to create a Template, 
following this section. For now, this setting will remain at "none," which means your NoteCards will 
be much like blank index cards, ready for your free-format data entry from within your book(s). If 
you use Templates, which we will set up in the next Help topic, the cards will contain bold prompts 
to help you think about your story elements and map out various aspects of your plot, conflict, etc.  

• Master NoteCard Type Limits: You may create unlimited numbers of NoteCard Types on this 
screen. Later on, when we walk through the assignment of specific NoteCards to your individual 
books, you will be able to select up to nine (9) of these NoteCard types per book, which will be 
displayed as you work in either Composition mode or Storyboard mode (as seen below).  



• Changing list order of the NoteCard Types: To change the list order of the Master NoteCard 
Types, click to select the entry you intend to move, then use the up/down arrow buttons at the 
right side of the grid on the Book Properties > NoteCard Types/Templates tab screen (as shown on 
top image) to rearrange your NoteCard Type list order.  

• Deleting Master NoteCard Types: If you wish to delete any of the NoteCard Types (including the 
pre-loaded samples), simply click to select the Type you wish to delete, then click the Delete 
button on the toolbar. This action will delete the NoteCard Type at the Master level only. Any pre-
existing WriteWay books that use the Master NoteCard Type you wish to delete now will not be 
affected. In other words, if one or more of your books contain a NoteCard Type for "Conflict" and 
you later decide to delete the Master NoteCard Type of the same name, you will not lose any 
individual book data or the "Conflict" NoteCard within those books. That deleted Master NoteCard 
Type will not be available to future books, but cards already in use are not disturbed. (To delete 
NoteCards in use for a given book, see the Help topic pertaining to Book Properties, NoteCard 
Types.)  

WriteWay comes pre-loaded with one sample template containing layouts for ten sample NoteCard types. 
You are not restricted to using just the sample templates; they are provided merely as a time-saving 
feature and a potential springboard to help you understand the various ways WriteWay can work for you. 
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From the Master NoteCard Types/Templates (found beneath the File menu or by clicking on the 
Master NoteCard Templates button on the Properties > NoteCard Types/Templates tab) screen double 
click on the NoteCard Type you want to make change to or view (you can also click the Templates button 
on the toolbar). This brings up the below screen, displaying a drop-down box of available NoteCard Types, 
and, below that, a box containing the current NoteCard Templates for the selected NoteCard Type.  
 

 
 
If this is your first time viewing this screen, the only template you will see here is the pre-loaded one 
named SAMPLE. In the Template Layout section of the screen you will see the example layout we have 
created for each of the NoteCard Types listed in the top drop-down box. If you scroll through the ten 
NoteCard Types we have pre-loaded, you will see each of the sample template layouts that have been 
included for your convenience. You may either use these layouts, or create your own custom templates 



using plotting and story creation techniques of your own design and preference. If you have added your 
own Master NoteCard Types in the previous Help topic, you will also see your entries in the drop-down list 
box. Your newly added Master NoteCard Types will contain no Templates, you will need to add them. 

• Creating Templates for Newly Added NoteCard Types: To set up a NoteCard Template layout 
for the NoteCard Types you created in the previous Help topic, first select from the drop-down list 
the NoteCard Type for which your new template layout will apply. Next, click the Add Template 
button on the NoteCard Template Toolbar. Type in a name for the new template you are creating. 
Note that this field is not asking for a specific NoteCard type (e.g., plot card, conflict card) but 
rather the name you would like to use for this particular template set of NoteCards, which will be 
available to you in any new books you create in WriteWay. For example, if you are writing different 
types of genre fiction, you might want to create NoteCard template sets using genre-specific 
labels, such as, "Romance Novel" or "Mystery Novel" or simply "My NoteCards". Don't worry about 
getting it perfect; you can always change the template name later (using the Rename button) or 
create entirely different ones.  

 

• Selecting a Template Style: Because the NoteCard Type(s) you created in the previous Help 
topic are new, the software will default the Template Style setting to "blank," as indicated by the 
radio button item beneath the template name field. If you were creating a new template for an 
existing NoteCard type--for example, creating your own template layout for one of the pre-loaded 
software NoteCard types--you would be given a choice to either create a new layout by starting 
from scratch ("blank"), or to modify an existing software's sample template as your base layout for 
the new template you are creating now. If you use the software template as the basis of your 
custom layout, you will still be able to change any and all data contained on the form. For our 
example here, let's say you're starting your new NoteCard template from scratch. Click "Use blank 
template" then click Create.  

• Formatting the new Template: After you click Create, you will be taken back to the NoteCard 
Template screen, which is now ready for you to input your own custom criteria for the NoteCard 
Type displayed in the drop-down box at the top of the input screen. To set up your new template 
layout, simply place your cursor in the large text area and begin typing the contents of your 
template. Template text is automatically formatted to bold-face, but you can make changes to the 
font type, size, and style, from the toolbar. When you are finished setting up the new template, 
click the Exit button, or, if you have additional templates to create, simply use the drop-down box 
to make your next selection and repeat the process described in this topic. Your changes to the 
Template screen are automatically saved.  

TIP: Creating meaningful NoteCards 
When designing your NoteCard Template layouts, think of NoteCards as a fill-in-the-blank reminder 
of the various elements you mean to incorporate into your book. Generally, they work best as 
prompts to make you think about your story and characters, and to help you stay on track from 
page one to the end. If you're not sure how to best use the NoteCards, take a few minutes to 
browse WriteWay's sample templates to see how we have used them in our pre-loaded Sample 
Book. 

Note: Changes to NoteCard Template layouts are automatically saved as you move from template to 
template or when you exit the screen.  
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Now that you have set up Master Templates for your Characters and story NoteCards, we'll move 
to the next step in creating a New Book. You can begin a new book by either selecting the Create New 
Book item from the File menu, or by clicking the Create New Book button on the main toolbar. This brings 
up a small screen that first prompts you to enter the New Book Title.  
 

 
 
Directly beneath the New Book Title field is the New Book File Name field. When you click or tab to this 
field, WriteWay will automatically repeat your book's Title as the book's File Name, which is how it will be 
stored on your computer hard drive. If you wish to create a different file name for your book(s), simply 
type a different name in the second text field. WriteWay saves all book documents and their supporting 
NoteCards and character profiles as the File Name entered in this field with the file extension of ".wwb". 

Below the title and file name fields is a drop-down box where you may select the genre settings and opt 
to copy properties from an existing book (optional). Should you use this feature, the properties that will 
copy over to your new book include: Author Name, NoteCard Types, Manuscript and Composition Settings 
(such as page margins, chapter heading styles, headers and footers). For the purposes of our example 
here, let's create our new book from scratch, without applying existing book properties. 

Type in your New Book Title (as you would like it to print on your manuscript, e.g., all caps, upper and 
lower case). Leave the Copy Book Properties set to the default of "None," then click the Create Book 
button. WriteWay will generate an outline with one Chapter and Scene and one mandatory NoteCard Type 
entitled "Plot." 

Note: When starting a New Book or Opening a book already started, it is not necessary to close a book by 
clicking the the X or going to File on the main menu and clicking Close Book. By clicking the New or Open 
Book, it will close the current book on the screen. If you have not saved changes made to that book, 
WriteWay will prompt you to do so. 
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By default, WriteWay saves your book files under a directory called "files" within the WriteWay main 
directory. While this is the best way to maintain an organized collection of your work, you are not required 
to save files to this directory. You might wish to save your book files in a separate subdirectory under the 
WriteWay "files" subdirectory. To establish a different location for your new book file, just click the 
"Browse" button on the Create New Book screen and make your path selection as desired. 
 

 
Later, when you wish to access a file that is not contained in the WriteWay "files" subdirectory, simply 
click the Open button on the toolbar (or Open Book from the File menu) and use the Browse function to 
locate your desired file(s). Alternately, you may use the Recent Books toolbar button, (or also found on 
the File menu). Selecting Recent Books from the toolbar will bring up a list of all the book files you've 
actively been maintaining and their associated locations on your computer. To select a book from this list, 
simply click on the title to open the file. Note: Cannot find your books on the Recent Books screen? 
Sometimes in an uninstall of WriteWay and a reinstall, the recent books list will be empty and you will 
need to use the Browse button to locate your saved books.  

 

 

 

If you wish to change the name of any book file, you can do this one of several ways. You can use the 
File>SaveAs... function to create a copy of the current book under a different name, thus creating two 
book files, each with a different name.  



 

You can change the name of a book file (without creating a copy) by clicking File>Open Book or 
File>Recent Books, then, using your mouse to highlight the desired book, click the Change Name 
toolbar button. This will bring up a small edit screen that prompts you to enter a new file name for the 
selected book. This function changes the actual file name only (e.g., "sample.wwb"), not the book's title. 
To change a book's title, see the Help topic Book Properties: Book Options Tab. 

 

 

 

It's a good idea to make a practice of backing up your WriteWay book files from time to time. For 
instructions on this process, please see the Help topic Backing Up Your Files. 

Note: Make sure to save your book from time to time! WriteWay has an AutoSave feature that will make 
a backup copy of your work should your computer accidentally shut down. WriteWay will prompt you upon 
reopening your book following and accidental shut down whether you would like to open the AutoSaved 
version. You can change your AutoSave features under the File main menu. Select your desired AutoSave 
Interval and WriteWay will save your work, according to your settings, every 30 seconds, 60 seconds, 90 
seconds, or 120 seconds. The default setting is 60 seconds. 
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Book Properties is where you will manage the overall appearance settings of your manuscript, 
both in Composition mode and in Print mode. Book Properties contains four tabbed sections: Book 
Settings, Draft Settings, Manuscript Settings, and Note Types/Templates. We'll go through them now, one 
by one, as we set up our new book. 
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Getting to know Book Properties: Book Settings Tab. 
 

 
 

• Author Name -- Enter your name as you would like it to print on your manuscript headers (if you 
use a pseudonym, enter it here).  

• Book Title -- This field is generated using the title you entered when you first clicked Create New 
Book. It will print on your manuscript headers as shown here. If you wish to change the title of 
your book at any time, you would enter the new title in this field. However, the file name created 
of where the book is stored will not change. Note: To change the name of a book file, use 
File>Open Book or File>Recent Books, then, using your mouse to highlight the desired book, 
click the Change Name toolbar button. This will bring up a small edit screen that prompts you to 
enter a new file name for the selected book. This function changes the actual file name only (e.g., 
"sample.wwb"), not the book's title. 

• Book Genre -- This field determines the sorting order of your new book among the many books 
you will eventually store in WriteWay. For ease of retrieval, the software allows you to group your 
books into genre groups (Mystery, Historical, Contemporary, Suspense, etc.). If you write under 
more than one name, you could also use this Genre field to separate your books by pen name or 
by targeted publisher or publishing line. To create a new group for the Genre sorting function, 
simply type over the displayed text with the group name you'd like to create. When you later click 



the Open Book button, your file list will be sorted according to the group type you set for your 
books in this field.  

• File Location -- This is an informational field that shows you where WriteWay is storing your 
current book file. The file name you first entered in the Create New Book step will appear here. 
Should you change the book's name later, this field will not change, nor can you change the file 
name from this screen tab. See above note. 

• Set Number of Acts -- Use the arrows to adjust the number of Acts in your book from 1 to 9. If 
you prefer not to use Acts in your book, set to 1 and all your chapters and scenes will be loaded 
beneath this singular Act. You can always go back in and add more later. Note: If you have the 
Standard Edition, you can only set up to 3 Acts in your book. 

• Show Plot Notes Checkboxes -- The three checkboxes listed below File Location allow you to 
select the NoteCard display settings for the various sections of your outline. As you work in 
Composition mode, WriteWay will display plot notes at higher hierarchical outline levels. If you do 
not wish to have those higher-level notes visible as you compose your scenes and/or chapters, 
click off the checkboxes as desired. This function is for Composition display purposes only; you will 
not lose your plot notes regardless of these settings.  

• Default Outline Font & Size -- For changing the font and size used for all Outlines in WriteWay: 
Book, Character, Research, etc.  

• Default NoteCards & Templates Font & Size -- For changing the font and size of all your 
NoteCards and Templates used in WriteWay. 

• Default Character Profile & Research Pages Font & Size -- For changing the font and size of 
all your Character Profiles and Research Folder Pages in WriteWay. Note:  When copying a 
character from another book, the inserted profile will adopt the font and size setting of the current 
book when inserted. 

Should you make any changes to the Book Settings Tab, click Apply on the Book Properties Toolbar to 
save these changes. If you click close before clicking Apply, WriteWay will alert you with a pop up window 
that changes are pending and ask if you are sure you want to exit. If you click "Yes," no changes will be 
saved. 

Note: The Help button on the Book Properties Toolbar brings up this Help menu. 
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Getting to know Book Properties: Draft Settings Tab. 
 

 
 

• Default Font and Size -- Click to select the font face and size with which you wish to compose 
your book. Note: This selection sets your Composition mode font. You can select a different font 
and size for manuscript printing. See Help topic Printing Your Manuscript for details.  

• Line Spacing -- Click to select the desired line spacing you wish to use in composing your book. 
Again, Composition mode and Manuscript Printing can contain their own font and line spacing 
formats. For example, if you prefer to compose your work in single-spaced Times New Roman font, 
but publisher guidelines require that you submit your printed manuscript in double-spaced Courier, 
WriteWay can easily handle both settings. And should you later decide to work or print in a 
different font, you can change your document's parameters here with a few easy mouse clicks.  

• Default Page Size -- WriteWay provides for two different page sizes:  

• Letter (8.5 x 11 in)  

• A4 (210 x 297 mm)   

Make your selection from the drop down box. 



• Margin Options -- Using the up and down arrow button, select your manuscript's page margins 
and header/footer margins. WriteWay's default margins are set at one inch on all sides, with half-
inch header and footer margins, which conforms to most publisher guidelines.  

• Default Left Tab Stops -- WriteWay's default setting for left tabs is one half inch, which conforms 
to most publisher guidelines. You may, however, change the spacing of your left tab by clicking on 
the arrow up or arrow down buttons at this field.  

• Use Paragraph First Line Indentation for Composition -- When starting a New Book the 
default setting for first line indentation is checked on. When this box is checked, WriteWay will 
automatically indent the first line of each new paragraph in your composition. This option can be 
activated in a book at any time as the existing text will auto-format.  

• Use Smart Quotes in all Composition and Notes --  When starting a New Book the default 
setting for Smart or Curly Quotes is checked on. When this box is checked, WriteWay will 
automatically convert standard single and double quotes to smart (curly) quotes as you type 
composition and/or notes text. This option can be activated in a book at any time, however, note 
that any existing standard single and double quotes in your text will not be automatically 
converted. Only newly entered text will use smart quotes. This feature is best used with new 
books. Otherwise, you will end up with mixed format, some text with smart quotes and some 
without it.  

Note: Draft settings tab is also used in determining the look and feel of your Publish-Ready book for 
eBook creation and uploading with Kindle and NOOK. Your font style and size can also be changed on the 
fly, however, in the Preview section of Writway, affecting only the export and print copy of your 
manuscript. 
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Getting to know Book Properties: Manuscript Printing Tab.  
 

 
 

• Default Font and Size -- Click to select the font face and size with which you wish to print your 
book. This will be the font used for manuscript page count estimates and preview/print functions. 
You will have the option of temporarily changing the print font on the Preview screen, but the font 
you select here will be the default.  

• Line Spacing Options -- Using the radio buttons, select either single, 1.5, or double line 
spacing for the printed format of your manuscript  

• Chapter Options -- Here you will set up the print format for your chapters. Decide whether or not 
you want your manuscript to print chapters with the word "Chapter"; select the number of blank 
lines preceding your chapter title from the top of the page (most publisher guidelines call for 
chapter titles to begin on line 10, so WriteWay's default setting is 9 blank lines preceding chapter 
title); using the radio buttons, decide whether you want your chapters to print with the numeric 
chapter numbers or words for numbers spelled-out (e.g., Chapter 1 or Chapter One); click the 
checkbox if you want your chapter titles as listed in your Book Outline to print on your manuscript; 
click the checkbox if you want your chapter titles to be printed in bold; click the checkbox if you 
want your chapter titles to be printed in all uppercase. 



• Scene Options -- Click to select a place marker for scene breaks in your manuscript (or leave 
unchecked if you prefer not to use a place marker for scene breaks). You may also type in your 
preferred indicator symbol for a scene break, if you wish. WriteWay's default setting is three pound 
(#) signs, each separated by one space, which conforms to most publisher guidelines. You may 
also select the number of blank lines to be inserted between your scene breaks; most publisher 
guidelines call for one line above and below a scene break, which is the default setting used by 
WriteWay.  

• Header Settings -- To set manuscript page headers in WriteWay, click the Edit Header button. 
This brings up a separate screen from which you can set your left, center, and right positioned 
headers. To save time, WriteWay allows you to enter several fields at the click of your mouse. Two 
of these fields--Title and Author Name--are generated from the Book Properties Book Options 
screen. The other fields--Date Printed, Time Printed, and Page Number--are automatically 
generated upon your selection. The Edit Header screen also allows you to change header font and 
size, as well as add bold, italic, or underline features to your headers. To save your header 
changes, click the Apply button. If you don't wish to save, click the Close button, which will return 
your header settings to the software defaults.  

 

• Footer Settings -- To set manuscript page footers in WriteWay, click the Edit Footer button. This 
brings up a separate screen from which you can set left, center, and right positioned footers. To 
save time, WriteWay allows you to enter several fields at the click of your mouse. Two of these 
fields--Title and Author Name--are generated from the Book Properties Book Options screen. The 
other fields--Date Printed, Time Printed, and Page Number--are automatically generated upon your 
selection. The Edit Footer screen also allows you to change footer font and size, as well as add 
bold, italic, or underline features to your footers. To save your footer changes, click the Apply 
button. If you don't wish to save, click the Close button, which will return your footer settings to 
the software defaults.  

 

TIP: Formatting Headers and Footers 
Although the left, center, and right header/footer text areas are not large, you can type beyond 
the display limits; your header/footer text will simply wrap around in the text area. To make sure 
your header/footer text does not extend too far on your manuscript, click the Preview toolbar 



button and make any changes as required. 

Note: This Manuscript Settings tab is set by default to print publisher guidelines. Any changes made to 
this tab will affect the way your manuscript prints. 
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Getting to know Book Properties: NoteCard Types/Templates Tab.  
 

 
 

• Selecting NoteCards for the current book -- The top portion of this screen displays a grid of 
the available Master NoteCard Types, which was described in an earlier Help topic. To assign 
NoteCard Types to your new (current) book, you need to select the desired type(s) from the top 
grid and Add them to the bottom grid. To select a Master NoteCard Type, simply place your cursor 
on the desired type and click to highlight it. Next, click the "Add" button to assign the selected 
Master Type to your book. Continue this process until you have added all the NoteCard types you'd 
like to use in this book. You can use up to nine (9) NoteCards per book with "Plot" being the 
default first card. 

• Re-sequencing the NoteCard display order -- The up and down arrow buttons, located on the 
far right of the Book Properties screen, allow you to change the display order of your book's 
NoteCard Types. These cards, in the order you select, will show up as tabbed NoteCards in 
Composition mode and "index-card style" NoteCards in Storyboard mode (WriteWay Professional 
Edition). The "Plot" card cannot be moved from the first position. 

• NoteCard Title Colors -- In Storyboard mode, NoteCards are displayed in visual format, like 
index cards arranged on a bulletin board. To help you differentiate the numerous card types in use 
with a given book, WriteWay allows you to assign and maintain unique colors to the title bars of 
each NoteCard using this screen. The only NoteCard color that cannot be changed is the Plot card, 



the sole required card in WriteWay. Plot is set to a fixed color, gray. To change the color of a 
NoteCard Type, simply click on the Title Color bar of the NoteCard you wish to change. A color 
palette will appear, from which you can make your selection(s).  

 

• Using a Default Template for NoteCards -- In an earlier Help topic, you learned about setting 
Default Master Templates for your NoteCards. On this screen, you will now apply those master 
templates to the NoteCards used for your new (current) book. To apply or change a template, click 
the Default Template bar for the NoteCard you wish to change. A drop-down box will appear, 
showing you the available Master Templates for the card you selected. Click to highlight the 
desired template. Note: WriteWay comes pre-loaded with Master Templates called SAMPLE. If you 
have not added any templates of your own, your choices here will be None (no template), or 
SAMPLE.  

 

• Template Apply Selection -- Now that you have selected a NoteCard Template, decide on the 
application of that template. The "Apply" column contains drop-down selections of "New" "All" or 
"None." By clicking the selection, you can either choose to have the template apply to New 
NoteCards (those added to your book from this point forward), None, or All. If you select All, 
WriteWay will automatically add the selected NoteCard Template to all of your existing book 
NoteCards and all new NoteCards.  

• Reapply flag -- Next to the Template Apply selection is a checkbox field labeled "Reapply." You 
would check this flag only if you have made modifications to a NoteCard Template and wish to 
apply those changes to your existing template selection. For example, let's say that within your 
Plot NoteCards, you are using a Template called "Romance Plot." After you began work on your 
book, you decided to add a new field to the template. The template itself remains the same--
Romance Plot--but the contents of the template has been modified. In order to apply the new 
layout to your book's existing NoteCards, you would need to check the "Reapply" box on the 
NoteCard Types/Templates tab in Book Properties.  

• Master NoteCard Types/Templates -- You can also access your NoteCard Types and Templates 
by using the toolbar button on top of the Properties: NoteCards Type/Templates screen. See the 
NoteCard Types and NoteCard Templates section of Help to learn more about setting up new Cards 
and Templates. 



Note: If you have data entered onto existing NoteCards already, you will not lose or overwrite it should 
you later decide to change a template layout. WriteWay simply adds the new template layout to the 
bottom of your NoteCard, appending to the end of whatever text the card(s) contain. 

When you have finished making changes to the Book Properties screens, click the Apply button. If you 
change your mind and wish to undo all of your changes thus far, just click Close. WriteWay will alert you 
to pending changes and ask if you are sure you wish to exit. By hitting yes, no changes will be saved. 
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When you begin plotting a new book, you may have only a handful of scene, situation, and character 
ideas formulated. From these kernels of information, once scribbled into spiral notebooks or onto 
countless sticky notes and index cards, you will start putting together your story and your characters. 
With WriteWay, all of that information can now be housed in one place, available right at your fingertips 
through your book's NoteCards (and Research Folders, if you purchased the Professional Edition of the 
software). 

To record these novel ideas and bits of sundry information onto WriteWay's NoteCards, you will begin by 
adding blank scenes or chapters to your Book Outline, if you have an idea of the specific chapter you are 
plotting, or into ScratchPad if you are doing general plotting and brainstorming. Your ideas need not be 
arranged in story order, nor do the scenes and/or chapters need to be completely mapped out. In the 
ScratchPad section of the Outline, your scenes and chapters will function as placeholders for the 
NoteCards that will contain the information and ideas you plan to use in building your story. To see an 
example of what a brand new, in-process book might look like using ScratchPad for the initial plotting 
stages, open the pre-loaded book file named Cindy Rella and the Prince. 



  

 

Changing Chapter/Scene Titles:  While plotting your book, you may find it easier to change the title of 
Chapter and/or Scene by entering placeholder "titles" to both story elements (150 maximum characters 
each). These titles will appear on the Book Outline, serving as a guidepost for you in viewing your story 
flow and organization. Optionally, you may also include these Chapter titles in your printed manuscript by 
selecting that feature under the Book Properties menu.  

When you add a Chapter or Scene to your book, you will get an auto pop-up screen asking you to change 
the title of the Chapter/Scene. Simply add a new title and click Change Name. If you wish to do this at a 
later time, simply click the Cancel or the X. When you are ready to name your Chapter/Scene, right click 
on the one you are wanting to add or edit, and click Change Scene Title. When you are finished, click 
Change Name to save the changes. Note: You can turn off the Automatic Name/Title Prompt under File 
on the main menu if you do not wish to have these prompts automatically pop up when adding a 
Chapter/Scene. You can add them later using the right click option. 

 



 

As your story progresses, you can then drag and drop those initial "idea" scenes and chapters onto the 
applicable sections of the Outline. WriteWay makes it easy to sketch out and monitor the flow of your 
book by breaking down the Outline into three Acts. You might find it helpful to plot out your story's major 
turning points, placing them in the appropriate Act, where they can perform as guideposts in your plotting 
process. 

If you're less of a plotter and more of a "seat of the pants" type of writer, you'll find that WriteWay's 
flexibility will work equally well with your personal writing style. You are not required to start your book in 
ScratchPad; if you have fleshed-out scene or chapter ideas, you can start writing them--with or without 
associated NoteCards--the moment you open your new book file. 
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WriteWay's NoteCards are one of the software's most powerful features. Functioning as both 
organizational and brainstorming/plotting tools, we think you'll quickly look to the NoteCards as an 
indispensable ally in your quest to craft cohesive, deeply textured novels from the first page to the last. 
Each time you add a scene or chapter to your book, WriteWay automatically attaches a full set of 
NoteCards to that scene or chapter, using the type selections and templates you chose when you were 
setting up your Book Properties. It's that easy! Now you're ready to record and organize your thoughts 
and ideas on a scene-by-scene, or chapter-by-chapter basis using WriteWay NoteCards. 
 
 

 
 

We described the setup process for NoteCards and their Master Templates in an earlier Help topic. Now 
we'll look at the NoteCards in action, as you'll use them in your books. 

 
Copyright © 2003-2012 WriteWayPro LLC 



 
Navigation: Plotting with WriteWay > 
What are NoteCards and How Do I Use 
them? >  

Tabbed NoteCards 

Send questions on this topic.

 

 
WriteWay's main workspace--the screen you will see whenever you start the software--is the Book 
Outline function. On this screen, you will notice that your workspace is split into two sections. On the left 
is your Outline, and on the right is your NoteCard selections, either in staggered tab format or 
Storyboard format (see next section). If you chose to use NoteCard Templates in your book setup, you 
will see those template forms displayed here when you click from one NoteCard to another. NoteCards 
that contain no story data are displayed with grayed backgrounds, indicating an empty (or template-
loaded only) NoteCard. 
 
To enter your story ideas and notes onto the cards, simply select the NoteCard you'd like to work with, 
click your cursor on the card and begin typing in your information. When you make a change to an 
otherwise empty NoteCard, you will see that the card background will change from gray, indicating no 
data, to white, indicating data is present. 
 

 
 

• Changing NoteCard Fonts: Your NoteCard's default fonts are selected on the Properties: 
Book Settings tab. To change the NoteCard's font style or size on the fly, you can either use 
the Edit drop-down box on the main menu, or right-click anywhere inside the area of the 
NoteCard and select Font from the selection list. This will bring up a selection box from which 
you can make your font changes (shown in the image above).  

• Loading a Template on the fly: WriteWay's flexibility allows you to load NoteCard templates 
as you work, without leaving the NoteCard workspace. To do this, simply select the Load 
Template item from the Edit drop-down box.  



 

• Adding images to NoteCards: From time to time, you might find it beneficial to add an 
image to a NoteCard. You can do so by right-clicking on any image, whether it is from the 
Internet or from within WriteWay, and selecting Copy. If you select an image from the Internet, 
WriteWay will prompt you to name the image or use the default 'temp_image1', giving each 
new image a different number. To add the image when you are on the desired NoteCard, right-
click and select Paste. The image will be pasted onto the card. You can change the size of the 
image by right-clicking and selecting Resize. The slider will enable you to change the size of the 
inserted image. You can use this feature for various reasons, such as seeing which characters 
are in what scenes at a glance. See below example of Cindy Rella and Mrs. Rella from our 
sample story: Cindy Rella and the Prince. Note: If you copy an image from one NoteCard and 
paste it onto another, WriteWay will remember the altered image and paste it the same size 
into the new NoteCard. Images will be pasted on top of one another, as WriteWay places all 
new images in the upper left corner, but then the image can be dragged to the desired 
position.  

 

Note: Make sure to save your book from time to time! WriteWay has an AutoSave feature that will make 
a backup copy of your work should your computer accidentally shut down. WriteWay will prompt you upon 
reopening it whether you would like to open the AutoSaved version. If you have made alterations to your 
book that you had not saved when your computer accidentally shut down, you should select "Yes" to 
opening the AutoSaved file. You can change your AutoSave features under the File main menu. Select 
your desired AutoSave Interval and WriteWay will save your work, according to your settings, every 30 
seconds, 60 seconds, 90 seconds, or 120 seconds. The default setting is 60 seconds. 

 
Copyright © 2003-2012 WriteWayPro LLC 



 
Navigation: Plotting with WriteWay > What 
are NoteCards and How Do I Use them? >  

Storyboard Mode (WriteWay 
Professional Edition) 

Send questions on this topic.

 

 
If you purchased WriteWay Professional, you have the added option of using the software's 
innovative Storyboard feature to build your book in a very visual format. In Storyboard mode, you can 
add chapters and scenes, and view and maintain all related NoteCards at once, a single set, or a select 
few of your book's NoteCards in a visual, "corkboard" style display. To switch from Tabbed NoteCards to 
Storyboard mode, click the Storyboard toolbar button or select View from the main menu and Storyboard 
from the drop-down box (keyboard shortcut: F9). 

• Storyboard Settings: The default display in Storyboard mode is to show only Plot NoteCards 
(with gray-colored title bars). To change this display setting and view additional sets of 
NoteCards, click the Show Storyboard Settings toolbar button. A new window will open that 
contains an entry for each of your NoteCard Types. To view any one set of NoteCards, such as 
Plot or Conflict, simply check mark that item. Your Storyboard display will change to show just 
that one selection of NoteCards. To view multiple sets of NoteCards--or all card types at once--
click all the Selected Note Types you wish to view. Based on your selections, you will then see 
your NoteCards and their corresponding title bar colors (which you set in Book Properties 
NoteCard Types/Templates) for the Outline item that's currently highlighted on the Outline 
workspace. You can also set which Outline Notes to show, such as: Book, Act, Chapter, and 
Scene by clicking the Show Tory Board settings button as shown in the image below. Simply 
check mark the box of the notes you wish to show on the storyboard.   

 

 

• Storyboard Format Option: WriteWay's Storyboard can be adjusted for NoteCard display as 
well. The default setting is four (4) columns and three (3) rows, showing a total of twelve (12) 
cards on the screen. See the below image. To show more or less cards, use the drop-down 
arrow to change the settings of rows. The number of columns will be determined by the boxes 
checked under Set NoteCard Types to Show.  Note: At some of the smaller card size settings, 
your templates and text may not be visible in Storyboard. To view text, simply place your 
cursor on the desired NoteCard and use the arrow up/down keys on your keyboard to scroll. To 
view the card in a larger window, double click on the NoteCard you want Zoomed, or right-click 
and select Zoom NoteCard to view and/or modify the contents in a pop up window that will 



appear at center screen. Please note that when in Zoom Mode, right-click does not work. To 
edit your card while in Zoom, use the Edit toolbar button on the top of the Zoom pop-up 
window. 

• Using images: You can also move images from NoteCard to NoteCard in Storyboard mode by 
using copy and paste. Simply right click on the image you want to paste on another card, select 
copy. On the card you want to paste the image in, right click and select paste. The new image 
will paste in the upper left corner of the card. Text will wrap around the pasted image. Note: if 
an image already exists in the NoteCard you are pasting in in the upper left hand corner, the 
newly pasted image will paste behind the existing one. Just drag the picture from on top of the 
newly pasted, then drag the images to the positions you want them. 

 

• NoteCard Colors: NoteCard title bar colors help you differentiate between the topics of each 
NoteCard. If you need a reminder of your color selections and their meanings, click the Show 
Storyboard Legend toolbar button. A small screen will appear and remain on top of your 
workspace as seen in the image below, showing you the NoteCard colors and their 
corresponding card topics.  

 

• Right-click Options: WriteWay's Storyboard function contains several additional NoteCard 



features available by right-clicking your mouse on a selected NoteCard. These features include:  

- Zoom NoteCard (very helpful if your display does not show all text, and you want to 
read the full text without scrolling -- one click and you see the whole card Note: From 
this display you can Add Template for on the fly changes to your NoteCards) 

- Cut, Copy, and Paste selected text  

- Thesaurus  

- Select All  

- Reset Text to Defaults 

- Set Line Spacing 

- Change Font, Tabs, Insert Symbols or create a numbered/bullet list in the NoteCard  

- Set Background Color (to highlight a NoteCard or group of NoteCards as a reminder or 
other special purpose; not applicable to empty or template-only NoteCards)  

To quit Storyboard mode and return to Composition mode, click the Composition toolbar button or 
select Switch to Composition from the View menu (keyboard shortcut: F9). 

Note: Font and size for NoteCards can also be changed by going to the Properties Book Settings 
Tab and changing the Default Settings. 
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In an earlier Help topic, we discussed the setup of Character Templates for use in WriteWay. Now let's 
apply your template(s) to the various characters that will populate your book. 
 

 
• New Characters: To add characters, click the Characters toolbar button, or select Character 

Profiles from the Book menu. This brings up a separate screen, which will be blank if you have not 
previously added characters to the current book. Click the Add button to bring up the Create New 
Character screen. In the first field, enter your character's name. Then, from the available list of 
Character Templates, as applicable, select a template you wish to apply to this character. Note: 
The Character Template box may contain only the SAMPLE template, if you have not previously 
created your own templates. You can add your own templates later, and apply them to your 
characters as you wish. Once you have made your template selection, click the Create button. You 
will see that your new character data is displayed in the Character Profile screen on the right of 
your screen, and the new character's name is located at the bottom of the character list on the 
outline. Complete this process for all of your characters, or continue working on the current 
character.  



 

• Adding Characters from other books: Click on the "Copy From..." button on the Create New 
Character screen to look for characters in other existing books. Select the book in the top part of 
the screen that you are wanting to copy a character from, see the image below. On the bottom 
portion of the screen, you will see a list of characters associated with that book. Once you locate 
the character you are looking for, click the "Copy Character" button to add it to the current book.  

 

• Adding Photos/Images: WriteWay allows you to add a graphic image or photo (.bmp, .jpg, or 
.gif) to represent each of your characters. To add one to the current character, place your cursor 
within the left side of the newly added Character Profile. Right-click your mouse and you will see 
Insert Image on the pop-up window. Click it to bring up an image selection screen. You may select 
an image from anywhere on your computer using the Select File navigation function, which should 
be very familiar to Windows users. Once you have located the image you'd like, click the Open 
button on the Select File screen. Once you've made your selection, the image will appear in the 
character photo box on the Character Profile screen. To increase or decrease the size of the added 
photo, right click the image and select Resize. Use the slider bar to increase/decrease the size of 
the photo. You can also use the right-click, select Copy, and right-click, select Paste to insert 
images either from your computer or the Internet, WriteWay will prompt you to name the image or 
use the default 'temp_image1', giving each new image a different number.  



 

• Changing Display Order: Once you have added multiple characters to your book, you may wish 
to change their display order in the character outline, e.g., list protagonist before secondary 
characters, etc. To do this, simply click on the name of the character you'd like to move, then drag 
that name to its new location in the list. Note: You must be viewing the character you are wanting 
to drag to another position before WriteWay will allow you to drag the Character Profile. 

• Changing Character Names: If you decide to change the name of a character, you can easily do 
so at any time. While in the Character Profile screen, highlight the character's name you are 
wanting to change and simply click the Rename button. This brings up a small edit screen, where 
you will be prompted to enter a new name for the currently displayed character. Type over the old 
character name, then click the Change Name button, or Cancel if you don't wish to apply the 
change.  

 

• Adding Character Pages: You can add pages beneath each Character created to store more 
information by selecting the character's name and and clicking the +Page toolbar button. This will 
create a blank page beneath the character to store more information about that character. These 
pages can contain text and/or images. To add an image, right-click and select Insert Image. The 
image can be dragged to position and the text will wrap the image accordingly. To 
increase/decrease the size of the photo, right click the image and select Resize. You can also use 
the right-click, select Copy, and right-click, select Paste to insert images either from your computer 
or the Internet. 

• Deleting Characters: To delete a character, click the Delete [x] button on the Character Profile 
toolbar. Deleting a character is a permanent action. Note: Deleting characters is not reversible. 
Once you've approved the delete and clicked YES, you cannot retrieve the character's profile.  

• Printing Character Profiles: Character Profiles may be Previewed and Printed using the Preview 
button on the Character Profile toolbar. Clicking this button will bring up the currently displayed 
profile, from which you can either view or print.  

• Right-Click Options: Much like the NoteCards in Storyboard mode, the Character Profiles function 
offers several features available by right-clicking your mouse. These features include:  

- Cut, Copy, and Paste selected text  

- Thesaurus   

- Select All 

- Change line spacing 

- Change Font, Tabs, or create a numbered/bullet list in the Character Profile  

- Insert Image/Symbol 

- Load Template (for on the fly template changes to your active Character Profile) 



TIP: Saving Changes. WriteWay automatically saves your Character Profile changes when you 
move to a different character or if you Close the window, however it is a good idea to occasionally 
click the Save button on the main toolbar to save global changes to your book. 

Note: Depending on the size of your monitor, while working on your composition, it is possible to have 
your Character Profile screen open, splitting your computer screen for Side-by-Side viewing by 
minimizing both screens. 
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WriteWay's Book Outline function is comprised of two main parts: Acts and ScratchPad. It is under 
these high level sections that you will organize and compose your story chapters and scenes. Take a few 
minutes to look over the sample book entitled CINDY RELLA AND THE PRINCE, which has been pre-loaded 
into WriteWay to help you better understand the look and feel of the Outline function. By default, the 
Outline will be fully expanded every time you open your book in WriteWay. To collapse the Outline and 
only have open the part you are working on, go to File on the main menu and click OFF on the Automatic 
Expand Outline. The next time you open your book in WriteWay, your Outline will appear collapsed. 
 

 
 



• Front and Back Matter -- The ‘Front Matter’ and ‘Back Matter’ folders can optionally contain extra 
pages where you can save additional information relating to the book. These pages can also be 
incorporated when exporting your book for Electronic Publishing. Right click on the Front Matter or 
Back Matter on the Outline and click 'Add Front/Back Matter' to bring up the below image. You can 
move (drag and drop) items back and forth between the two ‘Front Matter’ and ‘Back Matter’ 
folders on the Book's Outline as needed. Note:  A stack of white pages will appear as you drag 
page(s) to another spot on the Outline. If the stack of pages turn red and contains an x, that 
indicates a space on the Outline you cannot drop your dragged pages to. The Front/Back Matter 
page items are those included in the below image. Under Status, you will see a blank spot for a 
page not used, 'Used' for a page in use, and 'Add' when you click the empty space to add a page to 
your book's Outline. Under Print, you can change the 'No' to a 'Yes' if you want the page included 
in the printing of your book. Under eBook, you would click the 'No' to change it to a 'Yes' if you are 
formatting your book for electronic upload with Kindle and/or NOOK and you want the page 
included in your book. You can also click + User Page to add a page not seen below and create 
your own. After clicking the + User Page, simply type over the words User Page in the box to 
create your own title to the page. When you are finished, click Apply. Or click Cancel if you do not 
wish to save your changes.  

 

 
 

• Acts -- WriteWay's default setting is three (3) Acts, however, you may use as few as one Act 
(which will lump all of your chapters in one big section, for those of you not interested in using 
Acts) or as many as nine in the Professional Edition (Standard Edition allows a maximum of three). 
The Act headings will contain your numbered chapters and their correlating scenes, giving you a 
visual model of your book's entire story flow. Chapters and scenes can then be dragged and 
dropped to other locations on the outline as your story develops. WriteWay will automatically 
renumber your chapters. (See the Import section of this Help document for a tip on how to best 
drag and drop multiple outline items that have been ported over on import.)  

• ScratchPad -- functions as a catch-all for general scene or situation ideas that you are not quite 
ready to place within a specific Act or Chapter. Instead of turning to a paper notebook or sticky 
note, record those ideas in ScratchPad, where they will be available to you anytime at the click of 
your mouse. ScratchPad is also handy for those scenes and chapters that no longer seem to work 
in the book. Instead of deleting them, drag them down to ScratchPad until you are certain you 
don't need to resurrect them. To add a page to the ScratchPad, click on the ScratchPad, then 
click + Scene toolbar button or select Scene from the Book main menu to add a blank page. If you 
are wanting a folder and pages, then simply click +Chapter toolbar button. You can change the 
names of the Chapters and/or Scene with the automatic pop up box (or by right clicking your 
mouse if you have Automatic Title/Name Prompt turned off under File) and selecting Change 
Chapter/Scene title. ScratchPad items do not factor into your manuscript word count or page count 
reports, nor will they print as part of your manuscript. However, ScratchPad word counts will be 
included in the Word Count Report located under View of the main menu. Should you wish to, you 
can print ScratchPad from the Preview screen.  

TIP: Outline Width Adjuster. To expand the width of your Book Outline space, drag your cursor 



to the divider that separates the Outline from the NoteCard workspace. The mouse pointer will 
change to a right/left arrow. Adjust the Outline width by clicking and dragging the divider either 
left or right, to the position you prefer. There is a maximum allowable width; once you hit it, the 
divider will move no farther. 
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Beneath Acts on the Book Outline, will be your Chapters and Scenes. To populate the Outline, you can 
either drag and drop Chapters and Scenes from your ScratchPad area (if you used the ScratchPad for 
early plotting), or insert them directly into the Act sections by creating new Chapters and Scenes. 

For this example, let's assume you did not use ScratchPad and you are immediately ready to begin work 
on your new book's first Chapter. The first Chapter and Scene have been placed on the Outline for 
you. You can add additional Chapters by placing your cursor on the Act item you wish to add your Chapter 
to on the Outline and click the (+) Chapter toolbar button, or select Add Chapter from the Book menu. 
This action will insert a new Chapter in your desired Act. WriteWay automatically numbers your Chapters 
for you, and, should you decide to move a Chapter, or add a new one above it, the software will re-
sequence the Chapter numbers to reflect the modified order on the Outline. 

 

You will notice that corresponding NoteCards for Chapter 1 have been created in the Composition area (or 
alternately Storyboard, if you have WriteWay Professional Edition and have toggled to that particular edit 
mode). These NoteCards will help you map out the events that will occur at the Chapter level. As you add 
Scenes to this Chapter, corresponding NoteCards will generate for those Scenes as well. 

How this works: Let's say you expect that your Chapter 1 will contain two scenes, the first being a 
glimpse of your protagonist as the story opens, and the other being the event when he is called into the 
action of the story's plot. You may not have specific details or prose firmed up for each of those scenes, 
but you can use the NoteCards at the Chapter level to sketch out what you do know so far: general 
action, dialogue snippets, point-of-view character details, conflict potential for the chapter/scene, etc. If 
you do have specific details for a Scene within a given Chapter, you can skip ahead to anywhere in your 
Outline and begin work immediately, filling in your Scene NoteCards with as much information as you like. 
Or forgo these steps entirely and jump right into composing the text of those Scenes while they're fresh in 
your mind. 

Creating Chapter and Scene Titles 
In addition to being able to assign up to nine (9) NoteCards to each Chapter and Scene, you can 
also enter placeholder "titles" to both story elements (150 maximum characters each). These titles 
will appear on the Book Outline, serving as a guidepost for you in viewing your story flow and 
organization. Optionally, you may also include these Chapter titles in your printed manuscript by 
selecting that feature under the Book Properties menu.  

When adding a Chapter or a Scene, Change Scene/Chapter Title box will automatically pop-up. You 
can change the title and click Change Name to save and add to your Outline. Or you can click the 



Cancel or the X to bypass this option. Note: You can turn off the Automatic Name/Title Prompt 
under File on the main menu if you do not wish to have these prompts automatically pop up when 
adding a Chapter/Scene. To add a title to a Chapter or Scene at a later time, place your cursor on 
the desired Outline item and right-click your mouse. This action brings up a small menu list of 
options. Drag your cursor to Change Chapter (or Scene) Title and click to select this action. In the 
resulting User Input box, enter a title for your chapter or scene, then click Change Name.  

 

Chapter and Scene Titles are visible on the Book Outline and on your NoteCard title bars when you 
are in Storyboard mode. Unless selected as noted above, they will not print on your finished 
manuscript, but they will print as part of your Book Notes reports. (See the Help topic Printing Your 
Manuscript and Notes for more information.) 

Choose Scene Color 
You can change the color of the Scene page icon on the Outline to indicate things such as Hero 
POV, Heroine POV, level of suspense, black moment, etcetera. Right click on the Scene you want 
to change color, which will bring up the Choose Scene Color window as seen in the image below. 
Click on the color you want to choose, enter description and click Apply. You can change this color 
back or to another color at any time as well as change the description meaning. 

 

Scene Status Indicators 
In addition to changing the color of your page scene icons on the Outline, you can add a Scene 
Flag indicator. The scene flag would change the page icon to a flag of the same color as the page 
icon was. Simply right-click the scene on the Outline and click Set Scene Flag. Use this flag to 
indicate scene ready for manuscript, scene needs work, or whatever you want them to mean. 
When you want to remove the flag, simply right-click the scene and Reset Scene Flag. If you are 
wanting to clear all flags, click on Clear Scene Flags and all flag indicators will be changed back to 
scene icons. 

Regarding Prologues and Epilogues 
While WriteWay's Outline is based on Chapters and Scenes, the software does allow you to 
optionally add a Prologue and/or Epilogue to your book by converting the outline identifiers on 
Chapter 1 and the last Chapter of your book, respectively. To add a Prologue to your book, 
complete one of the following steps: 



• For a new book, where you have just begun to set up, place your cursor on the Chapter 1 item 
in the Book Outline, right-click your mouse. This brings up a small menu list of option. Drag 
your cursor to Change Chapter to Prologue and click to select this action. Your Book Outline will 
immediately reflect the change, with automatic renumbering of any chapters that follow your 
new Prologue entry.  

• If you already have composition and notes contained in a Book Outline item called Chapter 1, 
you will need to create a new Chapter above the first one and change that new chapter to 
Prologue, following the instructions in the previous paragraph.  

• To add/change a last Chapter entry into an Epilogue, the process is the same as above, except 
that you will be either adding or selecting the last Chapter entry on your Book Outline, and, 
upon right-clicking your mouse, you will need to select Change Chapter to Epilogue. 
Note: prologues and epilogues can not be moved (drag/drop) on the outline because they are 
fixed outline items and are always located at the top and bottom of the book outline. 

Adding Scenes to your book Outline is much the same as the process described for adding Chapters. 
Simply place your cursor on the Chapter item for which you are creating the Scene, then click the (+) 
Scene toolbar button, or select Add Scene from the Book menu. Your newly added Scene will appear 
beneath the selected Chapter on your Book Outline. Scenes are numbered sequentially within Chapters 
and their order will update automatically as you add and delete Scenes from your book. There is no need 
to type scene break indicators (# # #) into your story composition. WriteWay generates these 
placeholders automatically and will print them in your finished document as indicated in Book Properties: 
Manuscript Settings tab. 

To move a Chapter and its connected Scenes and NoteCards from one place to another on the Book 
Outline, simply click the Chapter item and drag to the desired new location. WriteWay will automatically 
re-sequence the surrounding Chapters and Scenes accordingly. (This action may also be carried out using 
the Storyboard function in WriteWay Professional Edition. See Storyboard elsewhere in this Help 
document for details.) 

To move a Scene and its connected NoteCards from one place to another on the Book Outline, simply click 
the Scene item and drag to the desired new location. WriteWay will automatically re-sequence any 
surrounding Scenes accordingly. 

Note:  When wanting to drag and drop a Chapter/Scene on the Outline, you must first click on the item 
you want to move so that it is visible in the composition area of WriteWay. Once you have clicked on the 
item, then you can drag and drop it on the desired position of the Outline. 

You may also delete a Chapter or Scene from your Book Outline by right-clicking your mouse and moving 
your cursor to Delete Chapter/Scene and clicking on it. Deleting a Chapter item from the Outline will also 
delete ALL of its connected Scenes and NoteCards, so use this function carefully. Note: You cannot 
retrieve deleted Chapters or Scenes once they are removed. If you want to remove a Chapter and/or 
Scene from the Book Outline, you may find it helpful to store those unwanted sections in the ScratchPad 
area of your book until you are certain you no longer need them. ScratchPad items do not factor into your 
word count, nor will they print as part of your manuscript. You can print your ScratchPad using 
WriteWay's Print Notes function, which is described in a later Help topic. 

Note: To see an example of what this beginning Chapter and Scene work might look like, take a few 
minutes to browse the pre-loaded book called Ciny Rella and the Prince. 
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While it's fun to play around with plotting elements and character building, at some point you must 
finally sit down and write. With WriteWay, you can start anywhere in your book, adding Scenes and 
Chapters for the various sections of the story that are crystallized in your mind and ready to roll from your 
fingertips onto the page. To begin composing the actual prose of your novel, on the Book Outline select 
the Scene with which you'd like to start. The first Chapter and Scene have been added for you. 

Note: Your story prose is to not be entered into the Chapter items on your Book Outline, but rather at the 
level below that, on a Scene by Scene basis. The software will handle the formatting and layout of your 
manuscript, inserting chapter and scene breaks as required. To see an example of how your Scene 
composition will look in manuscript form, with Chapter headings and Scene breaks, take a few minutes to 
browse the Print Preview function for the pre-loaded book called Cindy Rella and the Prince. 
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With the desired Scene selected on your Book Outline, you will notice that your Scene NoteCards 
are now at the bottom of your workspace, and a blank Composition page awaits you on the upper portion 
of the screen as shown on the previous Help screen. To begin composing the prose for this Scene, simply 
begin typing just as you would in any word processing program. WriteWay incorporates many of the same 
features and functionality you will find in MS-Word, which are indicated in the Composition screen toolbar 
and menu items. 

 

 

• Spellcheck: To run a spellcheck, simply click the button on the main toolbar, as seen in the image 
above, and WriteWay's dictionary will check the spelling of your scenes, and/or NoteCards. 
WriteWay's dictionary contains over a 250,000 words. (Keyboard shortcut = F7)  

-In WriteWay you can select different language dictionaries to use for 
spellchecking. Under the Edit menu there is a list of the available dictionaries to 
choose from: Dutch, English (UK), French, German, Italian, Portuguese and Spanish.  

• Thesaurus: To access WriteWay's Thesaurus, highlight the word you would like to search then 
either select Thesaurus from the Edit menu to bring up the Thesaurus or right-click your mouse 
and drag the cursor to Thesaurus and click on it. (Keyboard shortcut = Shift+F7)  

 

• Word Count/Page Count Estimates: WriteWay provides a running tally of your composition's 
word count and page count estimate at the bottom right of your workspace screen. Word counts 
are actual and calculated for each scene. Page count estimates are based on your specified 
manuscript format, which you specified in the Word Count Tracking section of the software. To see 
a total word/page count for your entire book, select Word Count Report from the View menu. 
(Details in the Reports section, further in this Help document.) Note: You must hit Save in order to 
see the actual word count in the bottom right corner or you will see the words "counts not current" 
will be present. 

• Split-Screen or Full-Screen Composition Mode: If you find you would rather compose your 
scenes in full-screen text mode, without the tabbed NoteCards visible as you write, simply click the 
Full Screen toolbar button or select View Full Screen from the View menu (Keyboard shortcut = 
F6). Full screen, which is enabled only when you are positioned on a scene, will toggle you 
between split- and full-screen word processing displays. To return to Split-Screen view, simply 
click the Normal toolbar button or hit Esc on the keyboard. While in full-screen mode, your scene 
NoteCards will not be visible. To access them, you will need to either toggle back to split-screen 
composition or click the Storyboard button on the main toolbar (Professional Edition).  

• Find/Replace: To perform searches of your composition or note text to find a specific criteria 
(words, phrases, etc). Simply click the Find button on the toolbar, or select the Edit menu item 
labeled Find (Keyboard shortcut = Ctrl + F). This brings up a small screen on which to make your 
selections. Depending on your location within your book, you will have the option of searching the 
current scene, current chapter, current act, or entire book. If you are in the Scratchpad, you may 



search that as well. To change the scope of your Find criteria, select the radio button to a higher or 
lower location on the Book Outline beneath the "Search Area" of the pop up window as seen in the 
image below. The Find feature will search either composition or NoteCard text, as indicated by the 
radio buttons.  

 

To perform a Replace search, click the "Replace..." button and you will be prompted to enter a 
search criteria (if one is not present) and the replacement text. You have the option to do a one 
replace at a time by clicking the "Replace" button or replacing all occurrences within the scope of 
the search by clicking the "Replace All" button.  

Additionally, you can perform Find/Replace searches on your Synopsis when you are working in 
that section of your book.  

• Change Default Views: While composing your novel, you may find certain elements of WriteWay 
distracting to your personal taste. You can alter the view by choosing to Hide Main Toolbar under 
the View in the Main Menu. To turn it back on, simply go back to View and click on Show Main 
Toolbar. You can also choose to hide the Text Ruler directly above the composition area by going 
to View and choose Hide Ruler. The ruler will remain hidden throughout all books unless you click it 
back on via the View menu. You can also change the color of the Default Blue background by 
clicking on File from the Main Menu and clicking Background Color Options and selecting Gray. 

• Add images to your text: While in composition mode, you can add images to your work. With 
your cursor where you wish the image to be placed, right-click. Select insert image from the pop 
up box. Once you have the image in place, you can drag the image by clicking on it and dragging it 
into position. The text will wrap around the picture upon placement. You can also resize the image 
by clicking on it and dragging on one of the small boxes. Note: Please note that the size of the 
image can impact the loading time of your pages. The larger the MB file size, the longer the load 
time. Adding images is a Professional Edition feature aside from Front Matter Cover Art page where 
Standard Edition allows you to include your Cover Art for the purpose of publishing electronically. 

• Drag and Drop text. While composing your novel, you can highlight the part of the text you want 
moved with your mouse, then drag it to the area you want to now position it. Note: You must first 
click on the page, then click again to highlight the text. 

As you compose the text for your Scene, you can easily click to any of the related NoteCards to check 
facts, recall scene ideas, etc. -- and never lose your place in your prose! 

WriteWay allows you to compose the text of your book using either single, 1.5 or double line-
spacing format--using the font face and style of your choice. What's more, the software is flexible enough 
that you can compose in one format and print your manuscript in another. This is a very handy feature for 
writers who, for example, prefer to compose in single-spaced Times New Roman, but are required to 
submit their work in double-spaced Courier. Now you can type in a format that's easy on your eyes and 
save yourself the bother of reformatting your manuscript's settings once it's time to submit. WriteWay will 
handle it all with a few easy mouse-clicks. (See the Help topic Printing Your Manuscript and Notes for 
more information.) Note: Should you change your font, or the spacing becomes incorrect from typing or a 
copy and paste, right-click and select Rest Text to Defaults. This will return your composition to what you 
set up in the Book's Properties section of WriteWay. 

When you've finished your work on the current Scene, save your changes by clicking the Save toolbar 
button, or by selecting Save from the File menu. (Keyboard shortcut = Ctrl+S)  

Note: WriteWay has an AutoSave feature that will make a backup copy of your work should your 
computer accidentally shut down. WriteWay will prompt you upon reopening it whether you would like to 
open the AutoSaved version. You can change your AutoSave features under the File main menu. Select 



your desired AutoSave Interval and WriteWay will save your work, according to your settings, every 30 
seconds, 60 seconds, 90 seconds, or 120 seconds. The default setting is 60 seconds. 

 

To begin writing another Scene, just repeat the simple process described above. There is no need to 
manually enter scene break indicators ( # # # ) or extra carriage returns at the bottom of your Scenes. 
WriteWay handles all of the formatting for you, which you can review by using the Print Preview function. 
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Your finished manuscript submission may require certain miscellaneous pages to accompany it to a 
publisher, agent, or for electronic publishing. WriteWay Professional allows for these special pages such 
as: cover art, cover page, reviews, copyright, dedication, acknowledgments, forward, author notes, 
glossary, and bibliography. To access them, select the Front Matter or Back Matter item from the Book 
Outline. Right click on the item you wish to add a page to and select the appropriate page. A blank sheet 
will display on the screen, ready for your text. 

Text entered on these pages are a what-you-see-is-what-you-get format. You will need to type these 
pages exactly as you would like them to print (or export), e.g., desired font type and size, line spacing, 
custom headers and footers, etc. You can make your font selections by using the font type and size drop-
down boxes at the top of the screen, or by right-clicking your mouse and selecting the Font item from the 
list. For this and other customizations, right-click your mouse and a selection list will appear, from which 
you will set your formatting. Note: See the sample book entitled Cindy Rella and the Prince document for 
examples of how these pages might look in finished form. 

Front and Back Matter -- The ‘Front Matter’ and ‘Back Matter’ folders can optionally contain extra pages 
where you can save additional information relating to the book. These pages can also be incorporated 
when exporting your book for Electronic Publishing. Right-click on the Front Matter or Back Matter on the 
Outline and click 'Add Front/Back Matter' to bring up the below image. You can move (drag and drop) 
items back and forth between the two ‘Front Matter’ and ‘Back Matter’ folders on the Book's Outline as 
needed. Under Status, you will see a blank spot for a page not used, 'Used' for a page in use, and 'Add' 
when you click the empty space to add a page to your book's Outline. Under Print, change the 'No' to a 
'Yes' if you want the page included in the printing of your book. Under eBook, click the 'No' to change it to 
a 'Yes' if you are formatting your book for electronic upload with Kindle and/or NOOK and you want the 
page included in your book. You can also click + User Page to add a page not seen below and create your 
own. After clicking the + User Page, simply type over the words User Page in the box to create your own 
title to the page. When you are finished, click Apply. Or click Cancel if you do not wish to save your 
changes. Note:  A stack of white pages will appear as you drag page(s) to another spot on the Outline. If 
the stack of pages turn red and contains an x, that indicates a space on the Outline you cannot drop your 
dragged pages to. You must first click on the item you are wanting to drag, so that it is viewable on the 
right side of the screen, before you are enabled to drag the item. 

 



 
 

To print any of the Front Matter or Back Matter, simply click the Preview toolbar button while the page 
you would like to print is displayed on screen. From the Preview screen, you can review your page layout, 
then click Print to send the page to your default printer device. 

Front Matter or Back Matter can also be exported as a Rich Text Files (RTF), Hypertext Markup Language 
(HTML), Adobe Portable Document Format (PDF), Microsoft Word Format 97-2003 (*.doc), and Microsoft 
Word Format 2007 and above (*.dox) for use in the word processor of your choice. To export, click the 
Export button on the Preview page. A small screen will display, prompting you to select a location on your 
hard drive, supply a name for the exporting file, and choose your desired format. 
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The Synopsis feature in WriteWay Professional allows you to create, print, and/or export your book's 
synopsis.  
 
To open your book's synopsis, go to Book on the menu and select Synopsis from the drop down box. Text 
entered on this page is a what-you-see-is-what-you-get format. You will need to type your synopsis 
exactly as you would like it to print (or export), e.g., desired font type and size, line spacing, custom 
headers and footers, etc. You can make your font selections by using the font type and size drop-down 
boxes at the top of the screen, or by right-clicking your mouse and selecting the Font item from the list. 
For this and other customizations, right-click your mouse and a selection list will appear, from which you 
will set your formatting. Note: See the sample book entitled Cindy Rella and the Prince document for 
examples of how these pages might look in finished form. 

WriteWay's Find/Replace feature will search your composition, NoteCards, and synopsis. To perform a 
search while in synopsis, simply click the Find toolbar button or from the Edit Menu click on Find 
(keyboard shortcut Ctrl+F). 

 

To print any of the Synopsis, simply click the Preview button on the main toolbar while the synopsis is 
displayed on screen. From the Preview screen, you can review your page layout, then click Print to send 
the page to your default printer device. 

The Synopsis can also be exported as a Rich Text Files (RTF), Hypertext Markup Language (HTML), Adobe 
Portable Document Format (PDF), Microsoft Word Format 97-2003 (*.doc), and Microsoft Word Format 
(*.dox) for use in the word processor of your choice. To export, click the Export button on the Preview 
page. A small screen will display, prompting you to select a location on your hard drive and supply a name 
for the exporting file. 
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WriteWay's composition function is designed around your book's individual scenes. You compose your 
book in WriteWay scene-by-scene, in any order you like. But what if you are working on one scene and 
wish to view the text for the scene or chapter immediately prior? There is no need to click out of your 
current scene to review what came before. Just click the first NoteCard tab, which is labeled "Chapter 
Scenes" and you'll see a display that shows the scenes before and after the one you are currently working 
on. If you want to review another section of your book, simply click the drop-down box and make your 
chapter/scene selection from the list as seen in the image below. You cannot type in this section (it is 
grayed out, meaning view only) but you can use this feature to review any portion of your book as you 
work.  

If you are working in full-screen composition, with NoteCards hidden, you will need to first click the Show 
NoteCards button in order to use this feature. 
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To save a Snapshot of your book, from the File menu, select Snapshot (keyboard shortcut F2). The 
below screen will pop up with the Snapshot Book Title and date, of when the Snapshot was taken, filled in 
for you. You can alter these titles to anything you desire. The Snapshot Book File Name is the File Name 
your Snapshot will be Saved As on your computer. If you wish to change where your file will be saved, 
use the Browse button to find the directory you wish to save the Snapshot in.  
 

 
 

You can set a Password from this screen to protect your work and prevent anyone else from viewing it. To 
change the genre of the Snapshot, use the drop-down arrow or simply type the genre you wish over the 
genre name already listed. 
 
A Snapshot can be used at anytime you make changes to your book and you aren't sure whether or not 
you are going to want to keep the direction you are going in. First make a Snapshot of your book, then 
later you can compare the new changes to the old. 
 
When you are finished, simply hit the Snapshot toolbar button. If you change your mind, click Cancel and 
your Snapshot will not be saved. 
 
Note: It is not possible to open two books at the same time in WriteWay. However, you can export your 
book into another format, and open in another processor such as WORD to compare the changes you've 
made in your book. 
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With a few clicks of your mouse, WriteWay can format and preview your book and all of its related 
notes and folders. In addition, if you purchased WriteWay Professional Edition, you will now be able to 
convert your finished manuscript into a professional looking Galley format (also known as Advance 
Reading Copy, or ARC), for distribution to book reviewers and for other promotional purposes -- in less 
than a minute's time! Need to have your scene read back to you? From the Preview screen, you can 
also select voice and WriteWay will use your computer's default text to speech voice to read back your 
work. 
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WriteWay's Print function is driven by the Preview screen, accessible from nearly anywhere in the 
software by clicking the Preview toolbar button, or by selecting Preview Book from the File menu 
(keyboard shortcut Ctrl + P). From the Preview screen, you can view the selected section(s) of your 
outline, manuscript and/or notes by paging through the documents using the arrow forward/backward 
buttons at the top of the screen or the Go To Page button, see image below. Also from the Preview 
screen, you can select Listen and WriteWay will use your computer's default text to speech voice to read 
back your work. 
 

 
 

On the far left of the Preview screen, you will see a frame that contains the Preview Options:  

• Composition (default)  

• Notes  

• Outline  

• Collapse/Expand buttons for easy outline viewing  

 

Below the Preview Options additional options are displayed based on the Preview Option choice you 
make. To the right of the Preview Options is a copy of the Book Outline and a document Preview 
section.  

Note: The larger your book, the longer it will take WriteWay to paginate and return your text to the 
Preview section.  

TIP: Something to understand about printing in WriteWay 
Even though you are seeing your book reformatted and adjusted according to your Preview 
selections, the actual text and layout of your book remains intact. The selections you make on 
Preview are temporary and do not affect the overall look or feel of your composition as it is stored 
in the software. Unlike other word processors, where the changes you make for printing and 
galleys either overwrite your document or have to be saved elsewhere in separate files, WriteWay 



lets you print and format on the fly -- and in most cases, faster than you can say New York Times 
Bestseller List! 
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First, determine how much of your book you'd like to preview. What you will see depends on which 
item is selected on your Book Outline. To preview your entire book, place your cursor on the "Book" item 
on the Outline (the uppermost entry of your outline) then click the Preview button. To preview a particular 
Act, Chapter, or Scene, select the desired section by clicking on the appropriate item of your outline, then 
click Preview. You can adjust your Outline selection once you are in Preview mode. Note: When 
viewing/printing your manuscript, your page count will start with the section you select to Preview. If you 
are on a single scene, then the first page of the scene will be page 1. If you select to Preview the entire 
Book, then page 1 will be the beginning of the book. If you include Front Matter Pages in your Draft, 
Manuscript, and Galley print options, they will be included in on the manuscript page count. 
 

 
You can optionally select the type of document you would like to preview.  

• Draft (default) -- which uses your composition font and line spacing settings  

• Manuscript -- which uses the manuscript font and line spacing settings you established in the 
Book Properties, which is set by default to print publisher guidelines. 

• Galleys (WriteWay Professional Edition) -- which uses your composition font and line spacing 
settings, but formats the document in a landscape, two-column format, ready for you to send 
out to reviewers and for other promotional purposes. There is an option to Show or Hide the 
separator line between columns. Note: if you are using images in your composition, then the 
galley format may not Print/Preview correctly due to the sizing of your images. 

• Publish-Ready -- Used for preparing your composition for electronic publishing such as 
Kindle, NOOK and Kobo or print if you want to add Front and Back Matter to your printed copy. 
By using the Options button, the screen pictured below, you can select to include Book Title at 
the top of the page, Table of Contents (which will include all items selected as 'yes' beneath the 
eBook column), Scene separators as well as things like Cover Art, Cover Page, Reviews, 
Copyright, etcetera to be included in either your eBook Export, or for Printing. Use the correct 
column provided. Spacing Options allow you to control the amount of spaces between the items 
before the next section on Description. These sections are not defined by complete pages. Use 
Apply to save your changes. Reset allows you to undo any changes you made before hitting 



Apply. Note: This option uses your Draft Settings and not your manuscript settings which is set 
to traditional publisher guidelines. Optionally, you can use the Change button (described below) 
on the above picture to change these settings on-the-fly and it will not affect your composition. 
The Reset button will change your fonts back to default if you made font changes via the 
Change button. 

 

Regardless of which option is chosen, the previewed composition will also contain your custom 
Headers, Footers, and page margins automatically applied. You will also notice that WriteWay 
automatically applies chapter headings and scene break indicators using the setup parameters you 
chose when you first created your book in the Book Properties. Note: Publish-Ready will not contain 
Headers and Footers as Kindle, NOOK and Kobo will add them in the conversion of the book when 
uploading to their respective sites. 

There is also an on-the-fly option to include Scene Titles with the previewed text by checking the box 
next to "Show Scene Titles." After checking this item, click Refresh toolbar button for the change to 
take effect. 

If you wish to change the font and/or font size while in Preview mode, the software allows for a 
temporary on-the-fly change for the previewing session you are currently conducting. To change the 
current font, click the Change button located at the bottom of the Composition Options box on the left 
side of the Preview section. This will bring up a small screen from which you can select a new font 
and/or font size. After you make your selection, click the OK button for the new font changes to take 
effect. 



 

TIP: How to handle print settings when you have used more than one font face in your 
book 
If, in Composition mode, your book contains more than one font type or size, when you select 
Manuscript from the Composition Options, any fancy fonts will be temporarily changed to your 
Manuscript Printing settings as indicated in the Book Properties screen. For example: Your 
Manuscript Printing setting is Courier New 12, but your Composition setting is Times New Roman 
14. Additionally, you have a section of text in your book where you have used a symbol font to 
illustrate a secret code your characters have to solve. When you go to print the document and 
select Manuscript as your print format, your document will go to the printer in Courier New 12. The 
fancy fonts will be converted to Courier New as well--only in print mode; nothing will change in 
your actual composition. If you know your book will contain multiple fonts, it is a good idea to 
make sure your Composition formats (font and line spacing) under the Book Properties area are 
the same settings you intend to use for printing your manuscript. Consequently, when you print 
your book, you would not select Manuscript on the Preview section, but rather, Draft, which is 
essentially a "what you see is what you get" printout of your composition document. 

After you have completed your selections and previewed your document's settings, to print simply 
click the Print button. To return to Composition mode without printing, click the Close toolbar button. 

 
Copyright © 2003-2012 WriteWayPro LLC 



 
Navigation: Previewing and Printing 
Your Composition and Notes >  

Preview Notes 

Send questions on this topic.

 

 
From the Preview Options section, click on the NoteCards option. You will notice that the NoteCards 
Option frame displays to make selections from the following items: 

• Report Format -- Only available with Professional Edition 

• Column Format -- Only available with Professional Edition  

• Portrait Layout  

• Landscape Layout  

• Insert Page Breaks -- Options include Never; Before Acts; Before Chapters; or Before Scenes. If 
you do not want forced page breaks in your previewed notes, leave the default setting at Never. To 
change the setting, make your selection from the drop-down list.  

• Show Book Notes -- If this box is checked, any NoteCards you have under the Outline heading of 
"Book" will be displayed/printed. Default setting is checked.  

• Show Act Notes -- If this box is checked, any NoteCards you have under the Outline heading of 
"Act" will be displayed/printed. Default setting is checked.  

• Show Chapter Notes -- If this box is checked, any NoteCards you have under the Outline 
heading of "Chapter" will be displayed/printed. Default setting is checked.  

• Show Scene Notes -- If this box is checked, any NoteCards you have under the Outline heading 
of "Scene" will be displayed/printed. Default setting is checked.  

• Skip Empty Notes -- If this box is checked, any NoteCards with empty templates, or that 
otherwise do not contain data will not be displayed/printed. If you click off this setting, your 
display will show all NoteCards, including those without data. Empty NoteCards will appear on your 
display/printout with a group of asterisks beneath their headings. Default setting is checked.  

• Show All or Selected NoteTypes -- You may opt to select Show All NoteTypes to display/print, 
or a selected number as shown on the colored checkboxes representing the in-use NoteCards 
associated with your book. Click to check on or off as desired. Default setting is Plot NoteCard Only 
checked. Note: If you select anything other than 'All' under 'Show Max. Characters', you will not 
see your images on your NoteCards. 



 

After you have made your selections for NoteCard Options, click the Refresh toolbar button for the 
changes to take effect. From here you can Print, Export (see Help topic Exporting Documents to Other 
Programs for details), or Close to return to Composition mode. 

Note: By default, the ScratchPad area will not automatically display or print with the rest of your 
NoteCards on the Preview section. Because ScratchPad is considered a work area, or holding tank, if you 
wish to print the contents of this section of your Book Outline, you must first click Composition under 
Preview Options, and select ScratchPad on the book Outline. The ScratchPad contents will display. From 
here you can Print, Export, or Close to return to Composition mode. 
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From the Preview Options section, click on the Outline option. You will notice that the Outline Option 
frame displays. You can either preview all items of your Book Outline or only those that are displayed 
based on which item is selected on your Book Outline.  
 

 
 

To show only the items that are Show as Displayed option, collapse and expand Book Outline items until 
you have the outline the way you want to print it and then click Preview and Print. This feature is 
particularly helpful in seeing the flow of your book's plot and action. If you employ meaningful chapter 
and scene titles, the Book Outline can become a road-map of your entire storyline, visible on screen at all 
times or in printed form for you to take with you or share with a critique partner, etc. 
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Exporting documents from WriteWay to Rich Text Files (RTF), Hypertext Markup Language (HTML), 
Adobe Portable Document Format (PDF), Microsoft Word Format 97-2003 (*.doc), and Microsoft Word 
Format (*.dox) format can be done with a few clicks of your mouse. With the document you intend to 
export displaying active on your screen, click the Preview button on the main toolbar. From the Preview 
section, click the Export button as shown below.  
 

 
 
This action will bring up a small screen that prompts you to save your selected document in Rich Text 
Files (RTF), Hypertext Markup Language (HTML), Adobe Portable Document Format (PDF), Microsoft Word 
Format 97-2003 (*.doc), and Microsoft Word Format (*.dox). You may rename the document if you like, 
by typing over the highlighted title in the save screen. When you are satisfied with the name of the new 
file, click Save. In seconds, your document is available for you to bring up in any supported program. 
 
Exporting in PDF -- Any file created in WriteWay and exported in PDF format, can be read in your iPad, 
iTouch, iPhone or any type of electronic that supports iTunes. Simply go to your iTunes Library, File > Add 
File to Library, and find the file on your computer you want to add. Once uploaded and your device is 
attached to iTunes, you can drag the PDF file to your device on the iTunes left sidebar. Note:  You will 
need a PDF reader on your device such as the free App Bookman. 

Manuscripts in draft or finished form, notes, and outlines can be exported from WriteWay, however some 
header and footer formatting may be lost and require tweaking in the resulting document. 

Note: Documents exported in RTF will be exported to a file folder titled RTF when exporting from 
WriteWay as with the older versions of WriteWay. All other file extension exports will be exported to a 
folder entitled Exports. This is due to updates made for version 1.9.1. 
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In addition to the many manuscript and note printing features described in the previous Help topics, 
WriteWay also provides some powerful document analysis reports that will help you gauge your progress 
on your book, and assist you in tightening your prose. These reports--all of which are located under the 
View menu--are described in the following Help topics. 
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From the View menu, select the Word Count Report to generate a word count analysis and manuscript 
page count analysis. This report will show you the actual word count for your book on several levels: Total 
Book, Acts, Chapters, Scenes, and ScratchPad word count will appear here as well. Track and monitor 
your progress in one easy step! The Word Count Report also displays your manuscript's line count totals 
and page counts, the latter being an estimate based on your manuscript settings as specified in the Book 
Properties section. Note: To get current count for your Scene/Book, make sure you save your work first 
before opening reports. 
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Select the Pie Chart toolbar button, or from the View menu, select the Word Count Tracking report to 
generate one of the most exciting features in WriteWay. The Word Count Tracking allows you to enter 
your manuscript's projected word (or page) count and deadline goal in order to produce a chart that will 
illustrate your required daily productivity level. You can view your original output requirement, your 
current minimum output requirement, and an alternate number, which can be accelerated productivity or 
more moderate productivity. Each day you work on your book, WriteWay will compute and chart your 
word/page count output toward the goals you have established. Change these goals at will or maintain 
your original estimates for gauging your actual progress. 
 

 
In addition, you can block out non-writing days by using the calendar feature located under the "Work 
Days" button at the top of the Word Count Tracking screen. Include or exclude weekends, block out single 
days or block out weeks at a time for holidays and vacations when you know you won't be writing. Once 
you've set this calendar, Apply your changes and WriteWay will recalculate your required productivity to 
accommodate your writing schedule. Imagine -- no more spreadsheets, calculators, or guesstimates when 
it comes to figuring out your deadlines and staying on track! 

The default display for the Word Count Tracking is the Daily Chart format, which you will see when you 
first click on this feature. At the bottom of this bar graph are two pie charts: one displays your daily 
progress percentage; the other displays your total manuscript progress percentage. To get a different 
view of your productivity, click the "Daily Log" button. This will show your productivity and goals in a 
tabular format. Either of these reports can be viewed on-screen or printed. Note: WriteWay must be shut 
down at the end of the day to determine a writer's day and the end of the day's word count. If left open, 
WriteWay will continue the next day's word count in with the previous day. WriteWay does not determine 
a writer's schedule, therefore word counts to not end at a specific time of the day. Some writer's may 
work past midnight and want those word counts included in that day's totals. 



 

When you select a deadline date after the start date, this date will be used to determine the ending time 
frame for calculating the graphs. Once completed, and you check mark the check box, no changes to 
word/page counts after this date will be displayed or used in graph calculations. Note: To get current 
count for your Scene/Book, make sure you save your work and your Completed box beneath the toolbar is 
not checked. 
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The Word Usage Analysis report is located under the View menu. Click to bring up a selection 
screen that will drive the parameters of your analysis report. The selection screen will prompt you to 
choose an area of your book to be analyzed, be it the book in total, a complete Act or Chapter, or a 
selected Scene. (The default selection is Book.) The second prompt allows you to select to report the 
appearance and frequency of all words used, or, if you uncheck that item, you can enter a range of usage 
to target the biggest repetition offenders. Once you have made your selections, click the Preview button 
to run the analysis. 
 

 
This report will give you several interesting insights about your book. For instance, if you look under the 
field labeled "No." you will get a count of the total number of unique words used in the entire book, or in 
the analyzed section of text, depending on your selections. You will also get an instant picture of all your 
"darling" words--those pets you use a few dozen times without even realizing it. And adverbs? Slash your 
passive prose by using this report to hunt down and kill as many adverbs as you can. The Word Usage 
Analysis is a copy-editor's dream report. 
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As you work on your book, you will undoubtedly collect many bits of information and resources that 
you may want to have on hand for fact-checking, continuity, etc. All of those bits of information, be it 
reference book annotations or quotes; quick facts, queries to complete at a later date, images, website 
URLs, file links--the list is endless!--can be contained in the Research Folders section of WriteWay 
Professional Edition. 
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To begin working with research folders, you first need to familiarize yourself with the options. The 
Preview button on the toolbar in the Folders section can change to Open or Print depending on what type 
of page/file/URL you added to your Outline. 
 

 
• Accessing Research Folders: Click the Research toolbar button, or select Research Folders from 

the Book menu. When you bring up this screen for the first time, the folder outline bar will be 
empty except for the top header label, "Research Folders." To begin, click the (+) Folder toolbar 
button. You will be prompted to give your folder a name. Type in the desired title, and click Save 
Name. If you choose to add this at a later time, simply click Cancel, and the folder will be added to 
the Outline with the default name of Folder. You can change/add folder names by first clicking on 
the folder, then clicking the "Rename" toolbar button. Enter an appropriate name when prompted, 
then click Save Name.  

• Adding Pages: To add pages to this new folder, click the (+) Page toolbar button. Give this page 
a name if you like, by following the same procedure as before. Research Folder pages can contain 
text, images, or combinations of both. Your new page will be displayed onscreen and ready for 
your data entry.  

• Entering Information: To enter text, simply click on the page and begin typing in the white text 
section. To add image(s), see below topic.  

• Adding Internet Links (URLs): To add an internet link to a Research Folder, bring up the 
desired folder and click the Browse toolbar button. Locate the website you'd like to link to by 
entering its URL in the "address" field of the browser screen and hit "enter." When the page you 
want is displayed, click the Add Link toolbar button. A new folder item called "Link" will be added 
to your selected folder. To change the title of the Link item, click the "Rename" toolbar button and 
enter a new name for the URL link. Note: Default Internet page is Internet Explorer and cannot be 
changed. 

• Adding Files: To add a file to a Research Folder, while highlighted on the desired folder, click the 
Add File toolbar button. Locate the desired file from your selected Directory in your computer. You 
will be prompted to Change Name. You can either change the files name and click Change Name or 
select Cancel to leave the name as is. To open the file from your Research Folder, highlight the file 
you want to open, then click the Open toolbar button. The type of file extensions that can be added 
are: doc; .docx; .rtf; .xls; .xlsx; .txt; .gif; .jpg; .jpeg; .wmv; .mov. 

• Add images to your text: While on a page, you can add images to your folders. Place your 
cursor in the desired page, right-click your mouse and you will see Insert Image on the pop-up 
window. Click it to bring up an image selection screen. You may select an image from anywhere on 
your computer using the Select File navigation function, which should be very familiar to Windows 
users. Once you have located the image you'd like, click the Open button on the Select File 
screen. Once you've made your selection, the image will appear on your page. To increase or 
decrease the size of the added photo, right click the image and select Resize. Use the slider bar to 
increase/decrease the size of the photo. You can also use the right-click, select Copy, and right-
click, select Paste to insert images either from your computer or the Internet, WriteWay will 
prompt you to name the image or use the default 'temp_image1', giving each new image a 
different number.  Note: All images will load to the upper left corner of the page and will need to 
be dragged to desired position, where and text will wrap around the image upon placement. Please 
note that the size of the image can impact the loading time of your pages. The larger the MB file 
size, the longer the load time. 



Tip: While working on your composition, it is possible to have a research folder open, splitting your 
computer screen for Side-by-Side viewing by minimizing both screens. 

Note: In order to use the browser function in Research Folders, you must have an active Internet 
connection. If your folders contain URL links, and you are not connected to the Internet during your 
WriteWay work session, an http error will appear on your Links pages in the folders. This is a temporary 
web error that will not appear when you are connected to the Internet, and it does not affect your actual 
link or the contents of your folder. 

Note: Since Research Folders are only accessible with the book is was created under, you can drop and 
drag folders from Research Folders to Future Book Ideas and back, providing both windows are open. 
Simply click on the item you wish to move, and drag it to the the new desired window. This will not 
completely move the selected folder, but create a copy of it in the new window. 

When you are finished working with the folders, simply click the Close button. WriteWay automatically 
saves your changes, however you will need to save your book by clicking the Save toolbar button. 
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Under the File menu, you will find the Future Book Ideas folder. Think of this space as a general file 
cabinet that you can access from anywhere in WriteWay. By adding folders and pages to the Future Book 
Ideas, you will be able to organize and maintain unlimited future projects---even bring those notes and 
ideas over into a new book file when you're ready. The Preview button on the toolbar in the Folders 
section can change to Open or Print depending on what type of page/file/URL you added to your Outline. 
 

 
To create a new folder, select the Future Book Ideas function from the File menu. When the screen 
loads, click the (+) Folder toolbar button. It's a good idea to give each folder a title/name to help you 
keep track of things. Once you have created a new folder, you will need to add the pages that will contain 
your text, images, and/or website links associated with this newly added folder. 

Add images to your text, select the page you want to add an image to. With your cursor where you 



wish the image to be placed, right click. Select insert image from the pop up box. Once you have the 
image in place, you can drag the image by clicking on it and dragging it into position. The text will wrap 
around the picture upon placement. You can also resize the image by right-clicking and using the Resize 
feature and dragging the zoom bar. Click Apply once you have the desired image size. Note: Please note 
that the size of the image can impact the loading time of your pages. The larger the MB file size, the 
longer the load time. 

TIP: Making the most of the Future Book Ideas Folders 
Just because the feature is called Future Book Ideas, don't feel you must limit yourself to using 
these folders for just book ideas alone. Add a folder and pages to store working titles for any and 
all of your books in progress. Keep a running log of your submissions by book, publisher/agent, 
etc. In short, you can store any information here that you might need to recall or retrieve during 
your writing session. The possibilities are endless! 

Note: Since Research Folders are only accessible with the book it was created under, you can drop 
and drag folders from Research Folders to Future Book Ideas and back, providing both windows are 
open. Simply click on the item you wish to move, and drag it to the the new desired window. This will 
not completely move the selected folder, but create a copy of it in the new window. 
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Research Folder and Future Book Idea folders can be printed in whole or in part by first clicking the 
Preview toolbar button. This brings up a preview of what your selected folder or page will look like on 
paper. If you have selected a folder, all pages within that folder will be displayed in the Preview section. If 
you have selected a single page within a folder, only that page will display in the Preview section. You can 
scroll through the selected pages by clicking the Page Forward/Backward buttons at the top of the Preview 
section. To select a different folder or page, click Close to return to the main folders screen and choose a 
new item from the outline. If you are satisfied with the previewed page(s), simply click the Print button 
and WriteWay will send your selection to your default printer. 
 

 
 

Note: Both the Research Folders and Future Book Ideas Folders can contain URL links to websites. In 
order to print the web page(s) in your folders, first select the Link page, then click the Print button on the 
toolbar. There is no Preview function when printing web pages from the folders; they are sent directly to 
the printer when you click the Print button. 
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WriteWay supports importing Chapter/Scene text into new or existing Books.  

• Importing into New Books -- is generally easier because WriteWay can directly add the 
imported Chapter/Scenes into the top of the Book Outline.  

• Importing into an existing Book -- is accomplished by adding the imported Chapter/Scenes into 
the bottom of the Book ScratchPad. Then you can click and drag the Chapter/Scenes to where 
you'd like them to be within your Book Outline.  

 

The importing process is the same for importing into new or existing Books. The imported text needs to 
be prepared so that WriteWay can search the text for key words that are either case-sensitive or 
uppercase. These key words tell WriteWay how to separate the imported text into Chapter and Scenes, 
the key words are:  

• Chapter or CHAPTER 

• Prologue or PROLOGUE 

• Epilogue or EPILOGUE  

• Scene separator, default of "# # #". You can change this separator to what you used in your 
existing book, such as "* * *". 

WriteWay allows you to choose which way you want the keywords to appear in your text, either as case-



sensitive or uppercase. However, you must choose one way and be consistent.  

Also, you will want to be careful that these words are only used in your text as import keywords. 
Otherwise, WriteWay will create Chapter and Scenes from text that you did not intend it to set up as a 
Chapter or Scene. 

Note: Please read the Help section Prepare Your RTF File for Importing before beginning this process to 
insure a smooth import process. 
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There are several things to consider before you begin to import existing text into WriteWay. Please 
review the following checklist to ensure a smooth import process. 

• It is easier if your existing manuscript is completely contained in one file, but this not a 
requirement. If you have saved chapters in separate files, you may first want to copy/paste the 
text and bring them together into one file, then save that complete file as RTF.  

• WriteWay's Import program will be searching for each of your chapter and scene breaks. Make 
sure that all of your chapter headings (or keywords) contain the uppercase word "CHAPTER" or the 
case-sensitive word "Chapter". The same requirement is for "PROLOGUE" or "Prologue" and 
"EPILOGUE" or "Epilogue". Your actual chapter numbers can be listed in number format or spelled 
out.  

 

• All scene breaks in the manuscript file should match the scene break indicator that you have set up 
in WriteWay's Book Properties area. Alternately, if your manuscript uses the WriteWay scene break 
(separator) default of "# # #" (no quotes, but with a space separating each pound sign), you need 
not adjust anything. If you use other characters as separators, then you will need to change them 
in the below screen shot from the Import window before importing so that WriteWay can find them 
to create your separate scenes. 

 

• If your manuscript contains "smart quotes" or "curly quotes" (such as those used in Word), you 
will first have to convert them to regular quotes before importing. Check your word processor's 
Help function for instructions on removing these types of quotes and replacing them with "straight" 
quotes. In Word, search the Help index for "smart quote". You can import a document containing 
curly/smart quotes, but they will transfer over in odd formats that you will later need to type over 
in WriteWay to correct.  

• If your manuscript contains special characters such as emdashes (long dashes between words) you 
should first convert them to regular type characters before importing. Emdashes should be double 
hyphens ( -- ) upon import. You can import a document containing special characters, but you will 
need to type over them in WriteWay to correct them. 

• If your manuscript contains Headers and Footers, you will need to remove them from the RTF file 
before beginning the import process. 
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After completing the preparation steps described in the previous help topic, in your word 
processing program, save your manuscript file as a Rich Text Format (RTF) file. Start WriteWay 
Professional. If you have an open book in WriteWay, you will first need to close that book before 
beginning the Import process to create a new book. 

• Click the New Book button on the main toolbar or select New Book from the File menu. Enter a 
Title for the book you are about to import, and, using the drop-down box, select new book 
properties to be applied to the book you are about to import (as applicable). You need not assign a 
property, however, by selecting an existing book property, your imported book will be given the 
same NoteCard Types and Templates, as well as your page settings, author name, etc. When you 
are finished, click OK.  

• WriteWay has now generated an empty book format into which you will now load your existing 
manuscript file. To start, select Import Book Chapters from the File menu. When the Import screen 
appears, click the Import button and using the Select File screen that appears, find the RTF file 
that contains your manuscript. Click the Open button and WriteWay will begin loading your file on 
the right side of the below screen.  

 

• The load process may take several seconds, the duration being dependent on the size of the RTF 



file you are importing. Once the process completes, the "Loading Book" message will disappear 
and you will see the first page of your manuscript displayed onscreen.  

• Now that you've loaded the file, you need to build your outline. Click the Build toolbar button to 
begin this process. You will immediately see a message box stating that chapter numbers need to 
be removed before building the outline. This is an automated process that WriteWay completes for 
you. The software will display its progress through your imported file, pausing at each occurrence 
of the word "CHAPTER" or "Chapter". It will then ask you to verify that the highlighted text is, in 
fact, a chapter number as opposed to an instance of the word "chapter" somewhere within your 
manuscript body text. If the highlighted text is a chapter number, click Yes as applicable to 
continue with the Import.  

• When you reach the final chapter heading and click Yes, the software will then automatically load 
your book's outline on the left side of the above screen. This will take a few seconds. When it 
completes, you will see that all of your manuscript's chapters have filled the outline, complete with 
separate scenes as applicable. If your manuscript contained a Prologue and/or Epilogue, those 
headings will also be present in the new Book Outline. Note: If you started with a New Book, the 
Import process will replace the empty generated first Chapter and Scene with the Import. If your 
book is not empty, meaning you have typed something in the first scene or typed into any of the 
NoteCards, the Imported book will load under the SctachPad and WriteWay will alert you as such. 

• Click Apply to accept your imported book. WriteWay will now begin transferring your imported 
Chapter/Scenes. You will see the imported text being loaded item-by-item to the main Book 
Outline. After a few moments, your newly imported manuscript is ready for you to use!  

TIP: Rearranging (drag-and-drop) imported Chapter/Scene sections 
Upon completion of the import, you will notice that all of your imported manuscript's chapters are 
loaded into the Act I portion of the Book Outline (except if your book contains an Epilogue; then 
that item will be loaded into the last Act). You may wish to break them up according to Acts, which 
you can accomplish by simply clicking and dragging chapters and their related scenes to other 
areas on the Book Outline. Because WriteWay automatically re-sequences chapter numbers as you 
move them, you might find it easier to follow the process if you drag and drop from the bottom of 
your outline and work up toward the top. For instance, if your imported book has twenty chapters, 
begin your drag-and-drop function by taking Chapter 20 first, placing it in the last position in the 
outline, then go back and do the same for 19, 18, 17, etc. This advice is also useful if you are 
working with drag-and-drop in an existing book that requires the movement of several 
chapters/scenes. 

Note:  When using Drag and Drop, you must first click on the Chapter/Scene you are wanting to drag 
so that it is visible on the right side of the screen. You may then drag the Chapter/Scene to the 
desired location. When you start to drag, you will notice a White stack of papers, indicating you can 
drag and drop successfully. Should a Red stack of papers appear, that indicates you cannot drop the 
Chapter/Scene on the Outline in that location, such as a Scene cannot be dropped into the Front 
Matter portion of the Outline. 

When you are finished, make sure to click the Save button on the main toolbar. 
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Want to bypass a publisher and place your work for sale online yourself? WriteWay can help you 
with Independent Publishing. In this section, we are going to give you step-by-step instructions of using 
WriteWay to save your project, export it into an .doc or .docx friendly file, usable at Kindle 
(Amazon.com), NOOK (BarnesandNoble.com or BN.com) and ePub (Kobobooks.com). 
 
First you will need to decide which properties (pages) you want included in the up-loadable file. Select the 
Front and Back Matter you are going to want to add to your book, such as: 
 

• Cover Art 
• Cover Page 
• Reviews Page 
• Copyright info 
• Dedication Page 
• Acknowledgments Page 
• Other Works 
• Author Notes 
• And more... 

 
Note:  When uploading to KoboBook.com Writing Life, you will need to make a separate Front Matter page, entitled 
Front Matter or whatever you want to entitle it and place all of your Front Matter pages (Cover Page, Copyright, 
Reviews, et cetera) on one singular page rather than separating to individual pages as when loading books for reading 
on Kobo Apps, your Front Matter pages will not load correctly. When you do the export for Kobo books only, click Options 
and turn off all Front Matter pages under the eBook column other than the one page you designed for Kobo uploading. 
Also, do not include your cover art within your exported file as Kobo will insert your cover art in the conversion to ePub. 
 
 

 
 

Adding Front and Back Matter Pages: Right click on Front or Back Matter on the Outline and select 
Update Front/Back Matter Pages. In the new window, beneath Description column, you will find pages 



available to you to add to your Front/Back Matter pages. Don't see what you want? Use the + User Page 
toolbar button to add a page. Simply type over the words "User Page" to change the title of your newly 
added page. Under the Status column, you would click on the blank box next to the page description you 
are wanting to add to your book's Front/Back Matter. The word "Add" will appear in the column. If the 
word "Used" appears, then the page is already in use in your current book. Beneath the Section column, 
you would choose whether to add the page to the Front or the Back Matter of the book by using the drop 
down arrow. To change the "No" to a "Yes" beneath Count, Print and eBook, simply click on the rectangles 
and WriteWay will change the "No" to a "Yes" (and back again) for you. Click Apply button to apply the 
changes or click Reset to cancel the changes you made and return the selections to the way it was when 
you first opened the window. 

 
Changing the Look and Feel of your Publish-Ready book: Select the look and feel of your eBook, 
such as font style, font size, and line spacing beneath the Draft Settings of the Properties toolbar button. 
This will all affect your final copy that you electronically publish. The properties you select will be added to 
the .doc or .docx file that you will export for uploading at Kindle and/or NOOK. In the Preview screen, you 
will want to select Composition beneath Preview Options (see first image below) and Publish-Ready under 
Composition Options. Click Options to draw up the second image seen below to select which options you 
want to include in your eBook, if you haven't already selected these in the above description of Adding 
Front and Back Matter Pages. Click Include Book Title (Publish-Ready does not use headers and footers, 
this will include the title at the top of the page for your ePublished book), Book Table of Contents (this 
creates a 'clickable' table of contents in your eBook), Convert Underlines to Italics (if you used underlining 
within your text to indicate italics), and Include Scene Separators (choose the separators such as * * *). 
Note: After exporting your .doc or .docx, you can always switch the Properties > Draft Settings back to 
the look and feel you prefer when composing your novel. Make sure you hit Apply to save your changes. 
You can also change the font style and size on-the-fly from the preview page, which will not affect your 
composition & notes by using the Change button. Reset will change back any changes you made before 
hitting Apply. 
 

          
 
Export: Use the Export (or Print if you choose to print your work) button to export your work from 
WriteWay. Select from the following options: Rich Text Files (RTF), Hypertext Markup Language (HTML), 
Adobe Portable Document Format (PDF), Microsoft Word Format 97-2003 (*.doc), and Microsoft Word 
Format 2007 and above (*.dox). When using WriteWay to convert up-loadable files, we suggest .doc and 
.docx for Kindle and NOOK and .doc for Kobo. Please see the following Help sections for further 
instructions. Use the Save File As: option to save your book to your computer in the folder you choose. 
Your book is now ready for ePublishing. 
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Uploading your book to Kindle Direct Publishing. https://kdp.amazon.com/self-
publishing/signin Kindle will prompt you to sign in using your account that you already have with 
Amazon.com. If you don't have an account, then you will need to sign up for one. Once you have an 
account, click the Sign In button. 
 

 
 
The next screen will be your Bookshelf, which will be empty if you haven't yet uploaded any books 
through Kindle. Click on 'Add a new title' to get started. 
 
On the next Page: 1. Your Book, you will be prompted to fill out your: 
 
Book Basics: 
 

1. Title: if this book is a part of a series, you will check mark the box and fill in the necessary 
information. 

2. Edition Number (optional): you would enter here if this is a first edition (first-time published) or if 
the content was previously published elsewhere and has been edited or otherwise changed, you 
would enter the new edition number. 

3. Description: this would be a blurb, small excerpt, and/or review that you would want to add to the 
book's page when displayed on Amazon.com. 

4. Book Contributors: You must enter at least one name (which would be author name) then you man 
add, editor, illustrators, translators or more. 

 
Publishing Details: 
 

1. Language: select language of the book 
2. Publication Date (optional): you can select a previous date, but nothing later than today's date. 
3. Publisher (optional): here you would fill in the name of your publisher. If none, you can leave blank 

and the author's name of the book becomes the publisher. 
4. ISBN (optional): International Standard Book Number would be filled in here if you have one, 

otherwise leave this field blank and amazon.com will take care of this for you. Note: if there is a 

https://kdp.amazon.com/self


print edition of this work, do not use that book's ISBN. 
 
Publishing Rights: 
 

• Either check the radio button to indicate that this work is public domain, or that you hold the 
necessary publishing rights. 

 
Browse and Search: 
 

• You would select the categories for which genre your book is best suited such as: 
Fiction>Suspense  

• You will also be prompted to enter keywords that describe your book, separated by commas. 
 
Product Image: 
 

• If you have an image for your book, you will be prompted to upload it. Kindle supports both .jpg 
and .tiff images. Click on the link to see what the guidelines are. 

 
Upload your Book File:  
 

• Here you would upload your .doc or .docx file you created and exported with WriteWay. Once you 
have uploaded, KDP allows you to Preview the upload. If you need to make changes in your 
uploaded book, you can simply go back to WriteWay, make your changes, export your file, then 
upload the book again. 

 
Book Content: 
 

• Use the radio buttons to select to either Enable digital rights management (DRM) or not. DRM 
inhibits unauthorized use and copying of your content. Once you select to enable or not, you 
cannot change this feature at a later date. To learn more about DRM: 
http://en.wikipedia.org/wiki/Digital_rights_management 

• Upload your .doc or .docx file of your book, using the browse button. 
 
Select Save and Continue to move on to the Rights & Pricing portion of entering your eBook for selling. 
 
Content Rights: 
 

• You will select the territories you hold rights: Worldwide Rights or Individual Territories (select 
territories). 

 
Royalty Option: 
 

• Here you will be asked to select the percentage of Royalties you want from your book: 35% or 
70%, and enter the amount you are wanting to charge for your book. If you enter a price below 
$2.99, you would get the 35% royalty.  

• Type in the price you want to list your book as in the calculator they provide. Once typed in, the 
calculator will show you your percentage dollar amount per book sold. 

 
Kindle Book Lending: 
 

• Allows Kindle Book buyers to lend your book to family and friends for a period of fourteen (14) 
days. If you do not wish this option, then you would need to uncheck mark this box. 

 
You are finished! Click the check marked box agreeing to their Terms and Conditions, then click Save and 
Published. Your new book will show up on Amazon's site in 24-48 hours. Note: You can always go back 
and make changes to your uploaded file or details once your book goes to Active status. Just use the drop 
down arrow by the word Active to make changes. Be aware--your 24-48 hours will start over, though the 
current copy of your book will still be available to be purchased during that time. 
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Uploading your book to Nook. http://pubit.barnesandnoble.com/ PubIt! (Barnes and Noble) will prompt 
you to sign in using your account with Barnes and Noble. If you do not have one, then you will first need 
to create an account with them. Once you have done that, type in your email address and password, then 
click Sign In. 
 

 
 
The next screen you come to will be your My Title's screen. This will be your bookshelf which will be 
empty the first time. Click 'Add Title'. 
 
Product Listing: 
 

1. Title 
2. List Price 
3. Publication Date: here you can plan to release the book at a later date, unlike Kindle. 
4. Publisher: which would be your name if you do not have a publisher. 
5. Contributor 1: Fill in the section for Role: Author, First Name, Last Name, City of Residence, and 

State (you can add up to 5 contributors such as: editor, illustration and such). 
 
Upload Your Book: 
 

• Here you would upload your .doc or .docx file you created and exported with WriteWay. Once you 
have uploaded, PubIt! allows you to Preview the upload. If you need to make changes in your 
uploaded book, you can simply go back to WriteWay, make your changes, export your file, then 
upload the book again. 

 
Upload Your Cover Image: 

http://pubit.barnesandnoble.com/


 
• If you have cover art, you would upload it here, following PubIt!'s guidelines. 

 
Help Reader's Find Your Book: 
 

1. Do you have an eBook-specific ISBN? you do not need one to publish with PubIt!. 
2. Is this NOOKBook part of a series? Use the radio buttons to select yes or no. If it is, then you 

would fill in the Series name and number. 
3. Is this NOOKBook available in print? Again, you would use the radio buttons to select yes or no. If 

yes, you would fill in the number of pages for the paperback. 
4. Is the book public domain? Your book is public domain if it is a book currently out of Copyright. 
5. What age group is this NOOKBook suited for? Use the drop down menus to choose an age group. 
6. What language is your NOOKBook written in? Use the drop down menu to select the language. 
7. Where do you have the rights to make your NOOKBook available for marketing, distribution and 

sale? Use the radio buttons to make your selection. 
8. Do you want DRE encryption for your NOOKBook? Use the radio buttons to select yes or no. Digital 

rights management (DRM) inhibits unauthorized use and copying of your content. Once this 
selection is made, you can not change this. To learn more about DRM: 
http://en.wikipedia.org/wiki/Digital_rights_management 

 
Tell Us More About Your eBook? 
 
Fill in the following boxes: 

• Subject Categories 
• Keywords for Search Engines 
• Description 
• About the Author (s) 
• Editorial Review # 1 (not written by the author) you can add up to five (5). 

 
Once you have completed the above, you will want to click Save to save all of your added information, 
even if you are not yet ready to publish. You can go back at a later date and edit what you inputed and 
publish the book. 
 
Royalty information: 
 
Royalties will be paid off the List Price:  

For eBooks with a List Price at or between $2.99 and $9.99  

• 65% of the List Price 

For eBooks with a List Price at or below $2.98 or at or greater than $10.00 (but not more than $199.99 
and not less than $0.99)  

• 40% of the List Price 

 
When you are done, you would need to check the box that you have legal rights necessary to make the 
content, cover image, and product detail available. Click 'Put on Sale'. 
 
PubIt! claims that it takes from 24-72 hours to publish your title and to have it listed for sale. Note: Our 
trial book took longer than the alloted time frame.  
 
Note: While in the processing state, you will not be able to make changes to your submission. 
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Uploading your book to Kobo. https://writinglife.kobobooks.com/  You will be prompted to sign in with 
Kobo Writing Life. If you do not have one, then you will need to create an account with them. Once you 
have done that, type in your email address and password, then click Continue. 
 

 
 

The next screen you will come to is your Dashboard. If you do not have any eBooks, then you will click 
eBOOKS at the top right of the page. This is the screen will list the books you have up for sale through 
Kobo. To upload a new book with them, click Create new eBook. 
 
Kobo Writing life has a very easy setup with easy to follow instructions, divided into four (4) sections. 
 
Describe the eBook: 
 
Click the Upload Your Book Cover to add your cover art. 
 
Type in the following items: 

• eBook Title 
• eBook sub-title (if you have one) 
• Series name (if you have one) 
• Author(s) (this will be filled in for you, change if you have a pseudonym and add other author 

names here)  
• Publisher name (if Independently Published, type in author name or name you are using to publish 

your books with) 
• Imprint (optional) 
• Publication date 
• eISBN (if you don't have one, Kobo will provide one) 
• Primary print ISBN 
• eBook language 
• Is this content part of public domain? (Yes or No) 
• Choose genre categories (up to 3 categories) 
• Synopsis (here you can also add a few reviews beneath the book's synopsis) 
• Click Save and Next if you are ready to move on (Or Save and Exit to finish at a later time) 

 
Add eBook Content: 
 
Here you will upload the .doc file of your book exported from WriteWay. Kobo will convert the file to an 
ePub file for you to review. Once finished, you will get the opportunity to preview the book by 
downloading it. Note: you must have an ePub reader on your computer to view it. 
 
Click Save and Next if you are ready to move on (Or Save and Exit to finish at a later time) 
 

https://writinglife.kobobooks.com/


Note: Remove cover art page before exporting in the Preview screen as Kobo inserts your cover for you. 
Use Options and click the yes, to make it a no, beneath eBook column. Also WriteWay suggests that you 
use only a .doc file as their conversion does not work with Table of Contents in .docx.  
 
Choose Content Rights: 
 
Click the Yes button to change to No if you do not wish to use the rights. 

• Apply Digital Rights Management? 
• Geographic Rights? 
• Click Save and Next if you are ready to move on (Or Save and Exit to finish at a later time) 

 
Set the Price: 
 
Set your price for your book and Kobo Writing Life will calculate the rest. Change the No to a Yes if you 
wish to override any of the foreign prices. 
 
Click Save and Next if you are ready to move on (Or Save and Exit to finish at a later time) 
 
Publish eBook: 
 
The publication date will be this day's date. If you chose a different date, change the date to the one 
indicated earlier in the process. Click Publish eBook, and you are now ready to start selling books at Kobo! 
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To help you understand WriteWay's features and functionality, we have included a sample book: 
Cindy Rella and the Prince in varying stages of development.  
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This sample book: Cindy Rella and the Prince is yours to do with as you wish. Make changes, 
move things around, run reports -- you can even delete it if you like. It is here merely as a tool to assist 
you in getting familiar with WriteWay. The sample book will illustrate the following: 

• Contains story work under Scratchpad 

• NoteCard data 

• multiple character profiles 

• Contains chapter/scene outline items 

• composition 

• miscellaneous pages 

• research folders  

• future book ideas 

If you have made changes to the sample, or if you have deleted it, and later decide you would like to 
restore it to its original form, you will find a "Restore Sample Book" option under the software File Menu. 
Clicking this menu item will recreate the sample as it was when you first installed WriteWay.  

 

You may use the Restore function as often as you like. 
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WriteWay installs differently on Windows XP and Windows Vista and Windows 7. If you install 
WriteWay using the defaults, then your WriteWay data directory would be:  

• Windows XP: C:\Program Files\WriteWay\files  

• Windows Vista and Windows 7: C:\Users\"Logon Username"\Documents\WriteWay\files  

Your WriteWay data is generally located in "...\WriteWay\files", if you used the defaults when installing 
WriteWay (which we recommend). The subdirectories under this location are where your work is generally 
stored. You can save your Book files in other locations, but for easier backing up we recommend you keep 
your files in the following subdirectories. They are:  

• books  

• images  

• rtf  

• exports 

The 'books' subdirectory, as you would expect, is where your Books (.wwb files) are stored. This is also 
where dictionary and thesaurus files are stored. In addition WriteWay runtime system data (.wwm file) is 
stored here. Which contains many runtime variables, as well as, your templates and Future Book Ideas 
Folders. Therefore, it is very important that all of these files are backed up regularly, if not daily.  

Note: If you have several projects, you can add subdirectories under the 'books' subdirectory to better 
organize them. Such as "...\files\books\thrillers" or "...\files\books\historical_01".  

Attention: Windows 7 and Vista Users: 

WriteWay was developed before Windows 7 and Vista and sometimes Win 7 and Vista needs to be 
reassured that a Win XP program and its components are ok to run. To resolve this compatibility issue, 
you need to do the following:  

1. Logon to your computer with administrator rights (required to install and use WriteWay to avoid 
security issues)  

2. Use Windows Explorer to locate the WriteWay.exe file in directory C:\Program Files\WriteWay (if 
you used the installation defaults) 

3. 'Right' click on the WriteWay.exe file  
4. Select Properties from the popup menu  
5. Click on the Compatibility tab  
6. Check the checkbox next to "Run in compatibility mode for:"  
7. Select XP SP 2 from the dropdown 
8. Check the checkbox next to "Run this program as an administrator"  
9. Click "Apply"  
10. Click "OK" to close all open windows 
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As with any work you do on your computer, it's a good idea to maintain regular backups of your 
WriteWay files. There are three (3) ways to backup your files.  

• Use the File menu "Copy WriteWay Files to Backup" function. This function allows you to 
choose a backup location on the current hard drive, a different hard drive, a removable backup 
media, or Internet storage such as Dropbox.com. It copies the entire contents of the 'books' 
subdirectory and optionally, the 'images' and 'rtf & exports' subdirectories to your backup location. 
The first time this function is used it copies everything and on subsequent times it only copies the 
files that have changed or are new.  

 

Note: Some removable media drives (e.g. flash drives) for some reason do not record the exact 
Time as the original copied file. The Time maybe off by one or two seconds making the files appear 
to be different when they are not. So, you might want to leave the checkbox "Ignore seconds in 
Date Last Modified field when checking for file differences" checked. If the Date Last Modified 
values are within 5 seconds of each other, then the files are consider the same, as long as their 
sizes are the same.  

There is also a File menu "Restore WriteWay Files from Backup" function that will restore the files 
from your backup location to the WriteWay locations. This feature is handy if you are transferring 
WriteWay files between up to four computers (see Using WriteWay on up to Four computers).  

WriteWay  allows you to Copy and Restore from multiple locations.  
 

• Use the "File/SaveAs..." function you can save the current open book under a new name to a 
different directory or separate storage media. While this could be done on a book-by-book basis, 



we recommend that you make periodic (if not daily) backups of your entire WriteWay 'books', 
'images' and 'rtf & exports' and save them somewhere on a backup media (see the next topic).  
 

• Use Windows Explorer (also referred to as File Manager) to make a backup. Insert the storage 
media of your choice, then open Windows Explorer and locate the place where WriteWay is 
installed. Expand the subdirectories until you see the 'files' subdirectory. Then we suggest you 
copy and paste the entire contents of the 'books', 'images' and 'rtf & exports' subdirectories to 
your backup media.  

• To keep multiple computers in sync you can use WriteWay's Copy and Restore features with a 
flashdrive as follows: 

  
On computer "A": 
1. Insert flashdrive 
2. Select "Copy WriteWay files to Backup" from File menu 
3. Set the "To Path" to your flashdrive (drive D:, E:, etc) by clicking the work "Browse..." 
4: Set the "Copy" options by clicking checkboxes, we recommend backing up all 
subdirectories 
5. Click "Copy Files" button 
  
On computer "B": 
1. Insert flashdrive form computer "A" 
2. Select "Restore WriteWay files from Backup" from File menu 
3. Set the "From Path" to your flashdrive (drive D:, E:, etc) by clicking the work "Browse..." 
4: Set the "Restore" options by clicking checkboxes, we recommend backing up all 
subdirectories 
5. Click "Restore Files" button 
 

You should backup all files in ...\WriteWay\files\books, but especially the .wwb files (your books) 
and the .wwm file (this is where WriteWay maintains various system and user data, e.g. Future Book 
Ideas). In the future there may be more files that need backing up, so it is best to backup all of them. 
Using the software's Copy and Restore functions beneath File menu is the best way to do this. 
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A printable list of Shortcut Keys within WriteWay:  
 
WriteWay incorporates a lot of the normal shortcut keys included in most word processors.  
 
Under File: 

• New Book   ctrl + N 
• Open Book   ctrl + O 
• Recent Books   ctrl + R 
• Save     ctrl + S 
• Save Snapshot  F2 
• Preview Book (Print)  ctrl + P 
• Select All    ctrl + A (note: must be turned to ON) 
• Exit WriteWay   ctrl + Q 

 
Under Book: 

• Change Screen Title  ctrl + T 
 
Under Edit: 

• Undo    ctrl + Z 
• Redo    ctrl + Y 
• Cut    ctrl + X 
• Copy    ctrl + C 
• Paste    ctrl + V 
• Find    ctrl + F 
• Find Next   F3 
• Spell Check   F7 
• Thesaurus   Shift + F7 

 
Under View: 

• Hide NoteCards  F4 
• Hide Composition  F5 
• Show Full Screen  F6 
• Switch to Storyboard  F9 

 
To access Help:   F1 
 
WriteWay also has Shortcut Keys for the following Special Characters as seen pictured below: 
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To use WriteWay on up to four computers (which you are allowed to do for your personal use per the 
WriteWay End User License Agreement), you need to install the WriteWay Demo and register it on all 
computers using the WriteWay installation program (wwSetup.exe). Then you will need to transfer (copy) 
the WriteWay files between the computers in order to keep them in sync. You should copy all files located 
in the 'books', 'images', 'rtf ' and 'exports' subdirectories. They are located in "...\WriteWay\files" (if you 
used the default when installing WriteWay, which is recommended. Moving WriteWay after the installation 
may cause WriteWay to error due to missing parameters.). Again, we suggest you copy and paste the 
entire contents of the 'books', 'images', 'rtf ' and 'exports' subdirectories to your backup media.  

You should copy all files in "...\WriteWay\files\books", but especially the .wwb files (your books) 
and the .wwm file (this is where WriteWay maintains various system and user data, e.g. Future Book 
Ideas). In the future there may be more files that need backing up, so it is best to backup all of them.  

Many of our users find using a flash drive for transferring files between computers works great. You can 
also use an on line storage system like Dropbox.com (see our section on Dropbox under Technical 
Support). Both provides an extra backup, which is recommend that you do daily.  

• To keep multiple computers in sync with a flashdrive, you can use WriteWay's Copy and 
Restore features as follows: 

  
On computer "A": 
1. Insert flashdrive 
2. Select "Copy WriteWay files to Backup" from File menu 
3. Set the "To Path" to your flashdrive (drive D:, E:, etc) by clicking the work "Browse..." 
4: Set the "Copy" options by clicking checkboxes, we recommend backing up all 
subdirectories 
5. Click "Copy Files" button 
  
On computer "B": 
1. Insert flashdrive form computer "A" 
2. Select "Restore WriteWay files from Backup" from File menu 
3. Set the "From Path" to your flashdrive (drive D:, E:, etc) by clicking the work "Browse..." 
4: Set the "Restore" options by clicking checkboxes, we recommend backing up all 
subdirectories 
5. Click "Restore Files" button 
 

We recommend that you use the "Copy WriteWay Files to Backup" and the "Restore WriteWay Files 
from Backup" functions with a flash drive or web address if you are using on line storage to make this 
easy to do.  

We also recommend that you install WriteWay with the same defaults on all computers and store your 
books in the same directory structure.  
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This section is for Windows Vista and Windows 7 Users who originally installed WriteWay 1.6.  

While WriteWay was developed prior to Microsoft's release of Windows Vista and Windows 7, WriteWay 
can be successfully installed and used on Windows Vista and Windows 7.  

However, due to file security changes that Microsoft implemented in Windows Vista and Windows 7 , our 
installation program needed to be modified for Windows Vista and Windows 7 to ensure optimal operation 
of WriteWay and to support new features. Therefore, we have updated our installation program to support 
Windows Vista and Windows 7 users. This revised installation program (wwSetup.exe) can be downloaded 
from our website at www.WriteWayPro.com.  

We recommend that you follow the re-installation procedure below to ensure a successful installation and 
correct use of WriteWay on Windows Vista and Windows 7.  

We apologize for any inconveniences that this may cause.  

WriteWay Vista re-installation procedure  

1. Backup ALL of your current files in the subdirectories 'books', 'images' and 'rtf ' under the directory 
...\WriteWay\files. This is the tricky part. You would expect to find these files under the directory 
C:\Program Files\WriteWay\files and the originally installed files will be there. But with Vista's new 
security (User Account Control Virtualization feature), your most current WriteWay files will be 
found under the directory C:\Users\Username\AppData\Local\VirtualStore\Program 
Files\WriteWay\files. If you don't see the AppData subdirectory then you will need to change your 
settings to "Show hidden files and folders" (see Windows Explorer's menu Tools, View tab)  

2. Do a complete uninstall of WriteWay, see Control Panel, Programs and Features  
3. Delete the directory C:\Program Files\WriteWay  
4. Download the current WriteWay Demo installation program (wwSetup.exe)  
5. Run the WriteWay Demo installation program (Note: you may need to re-register WriteWay)  
6. Copy your backup files to subdirectories 'books', 'images' and 'rtf ' under the directory 

C:\Users\Username\Documents\WriteWay\files (Note: this location is the same as 
"Documents\WriteWay\files\books")  

Note: Be sure to copy ALL files (including WriteWay files) in subdirectory '..WriteWay\files\books' 
Note: Replace the above Username with your Vista Login Id 
Note: You should use Microsoft's Windows Explorer for steps 1, 3 and 6  

Also, it is recommended that you install and run WriteWay as a user with administration rights 
on Windows Vista and Windows 7.  

WriteWay was developed before Windows 7 and Vista and sometimes Win 7 and Vista needs to be 
reassured that a Win XP program and its components are ok to run. To resolve this compatibility issue, 
you need to do the following:  

1. Logon to your computer with administrator rights (required to install and use WriteWay to avoid 
security issues)  

2. Use Windows Explorer to locate the WriteWay.exe file in directory C:\Program Files\WriteWay (if 
you used the installation defaults) 

3. 'Right' click on the WriteWay.exe file  
4. Select Properties from the popup menu  
5. Click on the Compatibility tab  
6. Check the checkbox next to "Run in compatibility mode for:"  
7. Select XP SP 2 from the dropdown 
8. Check the checkbox next to "Run this program as an administrator"  
9. Click "Apply"  
10. Click "OK" to close all open windows 

 

http://www.WriteWayPro.com


If you have any questions or problems, please contact us at contact@WriteWayPro.com 
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On occasion, you may have to contact customer support. You can do so by clicking @Contact Us on 
the About screen, or by simply sending us an email at: support@writewaypro.com. Note: Please take a 
moment to read the Feedback section of this Help file before contacting technical support. 
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WriteWay 1.9.1 and newer versions contain several upgrades that affect the way WriteWay 
presents and saves data. To ensure your work is protected, when WriteWay opens each of your books 
created prior to version 1.9.1, they will be saved as a backup named: {filename}_190.wwb. 
  
WriteWay recent upgrades include the following: 
  

• New Searchable and Indexed Help file 
 -- First time installations, the Help file will automatically pop up. 

• First Chapter and first Scene are automatically added to the creation of New Books 
• Drop and Drag text has been added 
• When adding new Scenes and Chapters, there is an auto pop-up asking you to rename your 

Chapter/Scene 
• The Book Outline 

 -- Front and Back Matter items have been added. Foreword and Author Notes are now 
under these items 

• Character Profile, Research and Future Book Idea Page images 
 -- The images are no longer presented separately from the text, but embedded in the text 
as in MS Word 
 -- The first time you open one of these pages, WriteWay embeds any images at the top of 
the page as best as it can. You can then drag and drop them anywhere in the text as you wish. 
The text will automatically wrap around the images as you rearrange them. 

• Status indicators for scenes have been added 
 -- Set flags icons for scene instead of page icons. You can set, reset and clear scene 
indicators. 

• New File links to Research/Future Book Idea Folders 
 -- You can now add existing file links in your computer to your folders for quick access. 

• Export text to Rich Text Files (RTF), Hypertext Markup Language (HTML), Adobe Portable 
Document Format (PDF), Microsoft Word Format 97-2003 (*.doc), and Microsoft Word Format 
(*.docx), making it easy to upload and electronically publish your own content at Amazon.com in 
Kindle and BN.com in NOOK formats 

• NoteCard Preview option to set row size on Storyboard 
 -- Columns are determined by boxes checked in Show Storyboard Settings. 

• Change the background color in the composition mode from the default blue to gray 
• Hide WriteWay's Toolbar from view in composition mode, then reset it at will 
• Hide the Ruler at the top of your composition and reset it at will 
• Word counting issues have been fixed and should be more accurate 
• Book Properties tab change and Composition settings to add Default font to NoteCards, Characters, 

and Research/Future Book Idea folders 
• First line auto Indent and Smart Quotes default set to on in New Books 

 -- Older books that do not have these properties checked, when user checks boxes under 
Book Properties will search through old text and adjust accordingly. 

• Optional Table of Contents to your Publish-Ready  exports. 
• Improved Storyboard features.  
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Navigation: Technical Support >  

Feedback 

Send questions on this topic.

 

 
For any questions, comments, or suggestions, please contact our technical support team at: 
 
support@writewaypro.com 
 
Please help us assist you by providing us with the following information: 
 

• WriteWay version. 
• Your Windows version. 
• Sequence of your actions that caused the problem. 
• As many details related to the problem as possible. 
• A screen shot (Alt + PrtScn) if possible of the error code. 

 
Note: Before contacting technical support, please review our FAQs page at WriteWay: 
 
http://www.writewaypro.com/faqs.php 
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Navigation: Technical Support >  

Lost License 

Send questions on this topic.

 

 
What to do if you lose your License Number: 
 
If you should lose your registration information and you need to either unregister your computer or simply 
register another computer, all you need to do is contact us:  
 
support@writewaypro.com 
 
We will email you your License Number to the email address you have registered with WriteWay. Should 
you need to change that email address, we can also update that for you. Simply email us at the same 
address and we will take care of that for you. 
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Navigation: Technical Support >  

How Can I Get Software 
Updates? 

Send questions on this topic.

 

  
Internet connection required  

From time to time, WriteWayPro.com may offer software updates to licensed users. These updates would 
include various program modifications and enhancements, or any program fixes as required. It is to your 
benefit to update to the latest release to make sure your copy of WriteWay is running at optimum 
performance. To make this easy for you, WriteWay contains an automatic software update feature that 
will perform a release check each time you start the software. It happens "behind the scenes" and only if 
you are connected to the Internet upon startup of WriteWay. 

If you have an Internet connection when you start up WriteWay the first time each day (if the File menu 
option "Automatic once a day release checking" is check-marked), WriteWay will check if a new software 
release is available. If there is a new software release available, a screen will appear that lists the various 
fixes and enhancements contained in the update. You will then have the choice to either download and 
install the update, or continue working without downloading the update. If you do not wish to download 
the software update, you can opt to get a reminder the next time you start WriteWay, or set a counter to 
remind you after a period of one to seven days. If you do wish to download the update, uninstall 
WriteWay completely by using the ‘uninstall’ application or Add and Remove Programs from your 
computer (be sure to click the "Yes to All" button when asked to remove shared system files). Then 
download and install the current version of the WriteWay Demo from our website 
http://www.writewaypro.com/download.php . 

Note: by using the uninstall application, WriteWay will not lose your work and can be uninstalled and 
installed many times. But we do always recommend that you back up your work regularly. WriteWay 
should recognize your registration when you download the demo. If for some reason it does not, go to File 
> Register WriteWay and reenter your licensing information. If you have misplaced this, let us know as 
we can resend you this information. 

If you do not have an Internet connection when you start up WriteWay, the release check will detect that 
you are not online and continue with your regular software startup. To manually check for software 
updates at any time, simply start WriteWay as you normally would (and make sure you have an Internet 
connection established), then click the Help menu and select the "About" item. This brings up the below 
small screen that displays your software version, license information, etc.  

http://www.writewaypro.com/download.php


 

Also displayed on this screen is a button labeled "New Release?". Clicking this button will connect with 
WriteWayPro.com online and check for any available software updates. If you already have the most 
recent update, you will get a message back to that effect. 

Note: From this screen, you can also connect to our Twitter and Facebook accounts by clicking the 
respective icons.  Keep up with the latest news from WriteWay! 

When you are finished, click the "OK" button to exit this screen and return to the WriteWay program. 
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Storing Files on Dropbox.com 

Send questions on this topic.

 

Steps to sync WriteWay with an Internet Storage system such as Dropbox: 
 

 
 

• Make sure all books are closed in WriteWay 
• File 
• Copy WriteWay Files to Backup 
• Under ‘To Path’ click on Browse 
• Find Dropbox under ‘Look In:’ Path should read something like but may not be exact 

‘C:\Users\(Your Admin Name)\Documents\My Dropbox\Books’ Note: Do not go beyond ‘Books’ in 
file path name. You could get the files lost in sun-directories. 

• Click ‘Copy Images’ or your Images will not be transferred 
• Click Copy Files 
• On second computer again make sure all books are closed 
• File 
• Restore WriteWay Files From Backup 
• Under ‘From Path’ click on Browse. Path should read something like but may not be exact 

‘C:\Users\(Your Admin Name)\Documents\My Dropbox\Books’ Note: Again, do not go beyond 
‘Books’ in file path name.  

• Click ‘Restore Images’. 
• Click Restore Files 

 
This should work. When you exit WriteWay, always click File, Copy WriteWay Files to Backup. This will 
insure your most up-to-date files are stored on Dropbox and when opening WriteWay, click Restore 
WriteWay Files From Backup. So no matter what computer you use, you will always have the most current 
file. 



 
Test the Dropbox system. 
 

• In a current book, type the words ‘Testing Dropbox’ (Note: You only need to do this with one 
book. All files will sync the same.) 

• Save book and close it 
• File 
• Copy WriteWay Files to Backup 
• Click Copy Files 
• On second computer, open WriteWay 
• File 
• Restore WriteWay Files From Backup 
• Open book and see if ‘Testing Dropbox’ appears 
• If yes, you are done. It works. 
• If no, close book 
• File 
• Restore WriteWay Files From Backup 
• Under ‘From Path’ click on Browse. Path should read something like but may not be exact 

‘C:\Users\(Your Admin Name)\Documents\My Dropbox\Books\Books’ Note: WriteWay tested this 
with four computers and for three of them the above test worked first time. With one computer we 
there was an additional sub-folder and added another ‘Book’ by clicking on the folder Books again. 

• Restore Books 
• Look for ‘Testing Dropbox’. If it is there, you are done and don’t change your restore to and copy 

to file paths. (Note: You may even have to go beyond the second book and add a third on the file 
path line.)  

 
Once you have them linked and the test works, go to your 2nd computer, which needs to be set up for the 
Copy WriteWay Files to Backup so that when you use that computer -- you can Copy your files to 
WriteWay and then Restore on the 1st Computer, which needs set up for Restore. Follow the same above 
examples using the same directions except start with Computer 2 for Copy and Computer 1 for Restore. 
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